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Appendix

Finale Libraries
Finale’s libraries contain reusable sets of musical elements: expression markings, for example, or 
chord-symbol suffixes. A basic set came with your Finale package; they’re in a folder called 
Libraries within your Finale folder.

You add a library’s contents to the active document by choosing Open Library from the File 
Menu. Feel free to modify these libraries, or to create new libraries containing your own sets of 
symbols. For more information on libraries, consult the appropriate entries, such as EXPRESSIONS, 
MUSIC SPACING, CHORD SYMBOLS, and so on. See also the SAVE LIBRARY DIALOG BOX for an 
explanation of the different types of libraries.

• Articulation Shapes. This library contains shapes to be used for articulations. You can create 
shapes to be used as articulations using the Shape Designer.

• Articulations (Maestro). This library contains a selection of single-character articulation 
marks that describe how a single note is to be played. You place them into the score with the 
Articulation Tool.

Finale’s Articulation Designer dialog box lets you add intelligence to the markings you 
design. You can train them to jump into place on a note, a specific distance from the notehead. 
You can also designate a secondary, “upside-down” symbol (called the Flipped Symbol) for 
Finale to substitute if the note’s stem direction changes.

Here’s a listing of Finale’s default articulations, and how their automatic positioning and play-
back features have been set up:

Main 
Symbol

Flipped
Symbol

Default 
Vert. 
Pos.

Handle Pos. 
M(H,V)/F(H,V)

 Playback 
Effect

Auto-Positioning Options Metatool

. .

 16     0,–4/0,0 Duration 40% Center, Note side, Avoid staff lines, Inside 
Slurs

S

16 0,-8/0, -32 Duration 30% Center, Note side, Outside Staff X

>  >   

 14 0,–4/0,–23 Velocity 125% Center, Note side, Outside Staff A

˘   fl   

 19 0,0/0,–35 None Center, Note side, Outside Staff Z

^   v   

 16 0,–8/0,–32 None Center, Above Note, Outside Staff V

¨   Ë   

 16 0,–8/0,–34 None Center, Above Note, Outside Staff G
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-    -    

 14 0,0/0,-16 Duration 105% Center, Note side, Avoid staff lines, Inside 
Slurs

E

¯   <   

 16     0,–2/0,–21      Duration 75% Center, Note side, Avoid staff lines, Inside 
Slurs

W

ä â

None 0,0/0,-30 Duration 125% Center, Note side, Outside Staff Q

U u   

 23 None None Center, Note side, Outside Staff F

Ÿ Ÿ

 36 None None Above, Outside Staff T

~     ~     

None None None Copy(H), Manually, Outside Staff Y

m     m     

 36 0,-13/0,-13 None Center, Note side, Outside Staff M

M   M   

 36 0,-13/0,-13 None Center, Note side, Outside Staff K

T   T   

 48     0,10/0,0      None Center, Above Note, Outside Staff J

≤  ≤  

 12 None None Center, Above Note, Outside Staff U

≥ ≥

 12 None None Center, Above Note, Outside Staff D

o   o   

 14       None None Center, Note side, Avoid staff lines O

O O

 23       None None Center, Note side, Avoid staff lines H

+   +   

 23       None None Center, Note side, Avoid staff lines I

1 1 16 0,-4/0/0 None Center, Above note, Avoid staff lines 1

2 2 16 0,-4/0/0 None Center, Above note, Avoid staff lines 2

3 3 16 0,-4/0/0 None Center, Above note, Avoid staff lines 3

4 4 16 0,-4/0/0 None Center, Above note, Avoid staff lines 4

5 5 16 0,-4/0/0 None Center, Above note, Avoid staff lines 5

°   °   

 60  0,–48/0,0 None Center, Below Note, Outside Staff P

Main 
Symbol

Flipped
Symbol

Default 
Vert. 
Pos.

Handle Pos. 
M(H,V)/F(H,V)

 Playback 
Effect

Auto-Positioning Options Metatool
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See STACCATO MARKS, and ROLLED CHORDS for more complete discussions of these mark-
ings and their playback definitions.

• Chords & Fretboards: Chord Suffix (Arial).LIB, Chord Suffix (Times).LIB, Chord Suf-
fix Expanded (Arial).LIB, Chord Suffix Expanded (Times).LIB, Chord Suffix (Jazz 
Text), Chord Suffix Expanded (Jazz Text), Chord Suffix (JazzCord), Slash Chords 
(Arial).LIB, Slash Chords (Times).LIB, Slash Chords (Jazz Text), Slash Chords (Jazz 
Cord). These sets of predefined chord symbols are used by the Chord Tool. Finale under-
stands each chord symbol in a musical way, and plays the chord back intelligently. The Chord 
Suffix & Fretboard libraries consist of a set of libraries: one containing the most commonly 
used chord suffixes and fretboards; the second containing an expanded library with more suf-
fixes and more fretboards per suffix; and a third library containing common slash chords. Each 
of these sets are duplicated three times, once for each of the following fonts: Arial, Times, and 
JazzText. The fourth set is a JazzCord font library which contains commonly used jazz suf-
fixes accompanied by fretboards created with Jazz Font characters.

*   *   

 60  0,-48/0,0 None Center, Below Note, Outside Staff L

g   g   

None       None Attack (0/–256) Copy Vertically, Manually R

!   !   

–48 12,–12/–12,–16 None Center, Stem side 6

@   @   

–48 12,–12/–12,–16 None Center, Stem side 7

æ   æ   

–48 12,–12/–12,–16 None Center, Stem side 8

"   "   

 12 36,–36/0,0 None Above, Outside Staff C

,   ,   

 36     24,8/0,0 Duration 50% Above note, Outside Staff B

…   …   

None       None None Manually N

( (

None       -26,-21/0,0 None Center, Note side 9

)   )   

None       26,-21/0,0      None Center, Note side 0 (zero)

Main 
Symbol

Flipped
Symbol

Default 
Vert. 
Pos.

Handle Pos. 
M(H,V)/F(H,V)

 Playback 
Effect

Auto-Positioning Options Metatool
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Libraries of like font type and design can be loaded together to expand the number of available 
suffixes and fretboards. So, if you’re working in a file based on the Maestro Font Default 
(which contains the first type of library in Arial font) and you find you need more suffixes or 
fretboards, loading the Chord Suffix Expanded (Arial) library will provide you with more 
options in the same style and font.When you load a new chord suffix library, Finale compares 
the suffixes. If the suffixes are identical in position and font, Finale won’t duplicate the suffix, 
but will load the new fretboard.

Adding the Slash Chord libraries works similarly, with the exception that these libraries only 
add fretboards when loaded into libraries of like font type (they don’t add additional suffixes). 
After loading this library, you’ll find slash chord fretboards added to existing Maj, m, min, 7, 
m7, and min7 suffixes.

The list below identifies the chord symbols in these libraries. Remember that you can modify 
any of these symbols (for example, to change “min7” to “m7”), and that you can add as many 
new ones as you want.

Slot

Number
Suffix

Slot

Number
Suffix

Slot

Number
Suffix

Slot

Number
Suffix

1 Maj 22 min6 43 m11 64 M9

2 min 23 6
9

44 m13 65
±

3 aug 24        6
min 9

45 m(maj7) 66
7b 13

4 dim 25 m 46 m9(maj7) 67 7b 9

5 7 26 M7 47 m7(add4) 68 7# 9

6 min7 27 m7 48 m7(add11) 69
b 13

# 9

7 sus4 28 M6 49 7sus4 70 b 13

b 9

8 Maj6 29 m6 50 7(b 5) 71 13

9 m7(# 5) 30 (add9) 51 7(# 9) 72 7# 11

10 aug7 31 (add2) 52 7(b 5b 9) 73 7sus2

11 
˜

32 M7(b 5) 53 7(b 5# 9) 74 13sus

12 
˜ 7

33 7(# 5) 54 9sus4 75 9(# 5)

13 Maj7 34 M7(# 11) 55 9(b 5) 76   # 9

7# 5
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Each library also stores a few additional learned chords that include an alternate bass note. In 
other words, Finale will correctly identify these chords, but they don’t necessarily appear in 
the Chord Suffix Selection dialog box. In the key of C, these learned chords are F/G, Dmin/G, 
and Dmin7/G; of course, Finale will recognize these chords regardless of the key you’re in, as 
long as they’re built on the same scale tones as these original learned chords.

• Clefs. This library contains sixteen standard clefs.

• Default Fonts. This library contains the default font settings, as found in the SELECT 
DEFAULT FONTS DIALOG BOX.

• Document Settings. This library holds all the settings that are saved in with your document 
such as the settings in the Document Options dialog box and a number of other settings in the 
Document Settings submenu, and other settings as well, such as the Playback Controls set-
tings.

• Engraver Articulations. This library, similar to the Maestro Articulation Library, has a num-
ber of Engraver symbols to be used for articulations. They are already adjusted to take advan-
tage of Finale’s positioning settings.

• Engraver Text Expressions. This library contains text expressions using the Engraver Font. 
Expressions such as dynamics and tempo indications are included.

• Executable Shapes. This library contains six predefined Executable Shapes, which can serve 
as the playback definitions for expressions. Each affects the specified playback parameter by 
26 units. That is, if you construct an accel. marking based on one of these Executable Shapes, 
the marking will produce a tempo increase of 26 beats per minute. For full instructions, see 
EXPRESSIONS—To define an expression for playback.

If you look at these shapes in the Executable Shape Selection dialog box, you’ll see three pairs 
of sloping lines. In each pair, the first shape produces an increase in the specified playback 
variable, and the second produces a corresponding decrease. The only difference between the 
three pairs is the amount of music affected by each: the change produced by the three pairs 
lasts for eight, four, and sixteen eighth notes, respectively.

14 9 35 M9(b 5) 56 9(# 11) 77 7sus(b 9)

15 13 36 M9(# 11) 57 13sus4 78 13sus(b 9)

16 7(# 11) 37 M13 58 13(b 5) 79   b 9 

7# 5

17 7(b 9) 38 M13(b 5) 59 13(b 9) 80   # 11

 7b 9

18 
+

39 M13(# 11) 60 13(# 9) 81   # 11

7# 9

19 11 40 m(add2) 61 13(# 11) 82   b 13

7n  9

20 m7(b 5) 41 m(add9) 62 6

21 dim7 42 m9 63 ø
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• Figured Bass. This library provides a simple starting place for entering figured bass into your 
document.

• Fretboard Styles. This library contains four fretboard styles, which define how Finale draws 
custom fretboard elements. The first three fretboard styles are the classic (4, 5 & 6 frets) style; 
the last was created with Jazz Font characters for a hand-produced look.

• Harp Diagram. This is a Shape Expression Library containing the two parts of a harp pedal 
diagram—the “skeleton” and the “pedals”—described in HARP PEDAL DIAGRAMS. See that 
entry for full instructions for placing and using this diagram.

• Instrument Libraries. The General MIDI library is designed to work with most synthesizers’ 
built-in sounds. Libraries are also included for the following synthesizers: Kawai K1, Korg 
M1, Proteus 1, Proteus 2, and Roland MT32. Each library contains a set of ready-to-assign 
Instruments (clarinet, piano, and so on), with the channel and patch numbers preset to match 
your particular synthesizer. Open the appropriate Instrument library for your synthesizer. Now 
show the Instrument List window, and, for each staff, choose the instrument from the Instru-
ment drop-down list. If you’ve set up your score to transmit patch information to your MIDI 
keyboard before beginning playback (see PLAYBACK), and if you’ve set up your MIDI key-
board to receive on the appropriate channels, you should immediately hear a multitimbral 
playback with the sounds you’ve specified. See MIDI CHANNELS for a description of Instru-
ments.

• Jazz Articulations. This is the articulation library to be used with the Jazz Font. It contains 
items such as staccatos, accents, house tops, falls and glissandos.

• Jazz Chords & Fretboards. See CHORDS & FRETBOARDS LIBRARIES.

• Jazz Clefs.This library contains sixteen jazz clefs.

• Jazz Default Fonts.This library contains the default font settings for the Jazz font, as found in 
the SELECT DEFAULT FONTS DIALOG BOX.

• Jazz Document Settings. This library changes items in your Document Settings that are 
appropriate for use in the Jazz font, especially the alignment of notes with their stems and 
flags.

• Jazz Dynamics. This is a library containing text expressions for the Jazz Font. It contains 

dynamics such as mezzo-forte (F) and double-piano (π).

• Jazz Measure Rests. This is a shape expression library which contains a multi-measure rest 
shape.

• Jazz Page Format. This library contains default settings for the PAGE FORMAT FOR SCORE 
DIALOG BOX.

• Jazz Rehearsal Letters. This library contains rehearsal letters from A-Z, all of which are 
enclosed in a box. This is also a text expression library.

• Jazz Spacing. This library contains spacing widths for use with the Jazz Font.

• Jazz Staff Styles.This library contains a basic selection of Jazz Staff Styles for use with the 
Staff Tool. See STAFF STYLES for more information.

• Jazz Stem Connections. This library contains stem connection definitions for use with the 
Jazz font. See STEM CONNECTIONS DIALOG BOX for more information.
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• Jazz Tempos. This library contains tempo indications in the Jazz font. This is also a text 
expression library.

• Jazz Text Repeats. This is a text repeat library for the Jazz Font. It contains items such as 
D.S. al Coda, etc. These expressions also come with brackets.

• Measure Rest. This library contains the default Multimeasure Rest symbol.

• Page Format. This library contains default settings for the PAGE FORMAT FOR SCORE DIALOG 
BOX.

• Percussion Maps. This library contains all of the percussion maps that you have created as 
well as default percussion maps for General MIDI. See GENERAL MIDI PERCUSSION MAP 
TABLE for a listing of instrument names which correspond to the MIDI Notes.

Notes Used in Percussion Maps

Percussion Map Name MIDI Notes Used

General MIDI 35-81

Cymbals 42, 46, 49, 51-53, 55, 57, 59

Guiro 73-74

Wood Blocks 76-77

Agogo Bells 67-68

Triangle 80-81

Cuica 78-79

Whistle 71-72

Drum Set 35-38, 41-53, 55-57, 59

Bongos 60-61

Timbales 65-66

Congas 62-64

Snare Drum 37-38

Quad Toms 41, 45, 47, 50

Quint Toms 41, 43, 47, 48, 50

Tom Toms 41, 43, 45, 47, 48, 50

Bass Drum (5-line) 36, 41, 43, 45

Treble Clef Entry 62, 64, 65, 67, 69, 72-79, 81, 83

Treble Clef Entry, General MIDI playback 62, 64, 65, 72-79, 81, 83

Bass Clef Entry, General MIDI playback 43, 45, 47, 48, 52-57, 59, 60, 62
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• Pitch Bend. This is a single Text Expression in a library by itself. It consists of the words 
“pitch bend,” and has been defined to produce a single pitch bend. This pitch bend lasts for 
one whole note. It moves the pitch wheel from its “at rest” position all the way to the top of its 
range of movement, then back down to its “at rest” position. For a full description of pitch 
wheel usage in Finale—including instructions for the creation of this particular pitch bend 
expression—see PITCH WHEEL.

• Quarter Tone. This Key Signature library contains a single key signature— namely, the key 
signature for a quarter-tone key system, where there are three chromatic steps between two 
diatonic steps (instead of the usual one). If you set your piece in this key signature, bear in 
mind that one key on your MIDI keyboard corresponds to one chromatic step in the music. In 
other words, you won’t be able to play normally and still get an accurate transcription of your 
playing, because—for example—the C# key on your MIDI keyboard will correspond to a C-
quarter sharp on the screen. See NONSTANDARD KEY SIGNATURES for more information.

• Shape Expressions. This library contains a selection of Shape Expressions for use with the 
Expression Tool. While it does contain several phrase markings and hairpins (crescendo mark-
ings), remember that it’s far easier to create phrase markings and hairpins using the Smart 
Shape tools. The sole advantage to using these crescendo hairpins is that they have been 
defined for playback; they produce a volume change of 26 MIDI key velocity units in the time 
of a whole note. This library also contains a glissando line and tremolo marking, as described 
in GLISSANDOS and TREMOLOS, respectively.

• Staff Styles. This library contains a basic selection of Staff Styles for use with the Staff Tool. 
See STAFF STYLES for more information. The following metatools appear in the Maestro Font 
Default file.

Staff Style Metatool Assignment

Slash Notation S

Rhythmic Notation R

Blank Notation: Layer 1 B

Blank Notation: Layer 4 K

Blank Notation: All Layers A

Normal Notation M 

One-Bar Repeat O

Two-Bar Repeat T

Standard 5-line staff F

1-line Staff: Full Barline N

1-line Staff: Short Barline N

Hide Staff H

Percussion: 1-line Staff P

Percussion: 5-line Staff C



Finale Libraries A-9      

OC

OC

ndex

Index

revious
hapter

revious
hapter

ext 
hapter

ext 
hapter
T

T

I

P
C

P
C

N
C

N
C

• Spacing Widths libraries: Fibonacci Spacing • Fibonacci Edited Dots • Tight Spacing • 
Medium Spacing • Loose Spacing. These libraries contain spacing width tables used for the 
spacing of notes and lyrics. Fibonacci Spacing is the default which spaces your music using a 
ratio of about 1 to 1.6. So a quarter note will take up 1.6 times the space of an eighth note. To 
find out how you use these libraries, see MUSIC SPACING. The library titles indicate the relative 
spacing of the entries in a measure; music that’s been spaced using the “medium” library will 
be more compact than music spaced with the “loose” library.

• Text Expressions (Maestro). This library, for use with the Expression Tool, includes a num-
ber of expression and dynamic markings, many of which have been defined for playback. The 
dynamics always appear in Maestro music font, and the other expression markings appear in 
the Times New Roman italic font; feel free to change these fonts to suit your system. (For the 
non-dynamic expressions, choose a PostScript font if you plan to print on a PostScript printer 
or a True Type font if you plan to print on a non-PostScript printer.) This library also contains 
some sample rehearsal letters.

The playback-defined expressions in this library are as follows:

Note Shapes X

Flute Transposition 1

Bb Clarinet Transposition 2

Eb Alto Saxophone Transposition 3

Bb Tenor Saxophone Transposition 4

Expression Playback effect Value

Ø

Key velocity 10

∏

Key velocity 23

π

Key velocity 36

p

Key velocity 49

P

Key velocity 62

F

Key velocity 75

f

Key velocity 88

ƒ

Key velocity 101

Staff Style Metatool Assignment
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• Text Repeats (Maestro). This library contains a selection of text repeats—textual repeat indi-
cations, such as “D.S. al Coda,” that are fully functional for playback. You create and edit 
repeats using the Repeat Tool.

The text repeats in this library are as follows:

The number sign (#), when it appears in a text repeat, represents a temporary “stand-in” for 
some variable. For example, if you place the “To Coda #” or the “D.S. al #” marking in the 
score, Finale will automatically substitute the text of the target (“Mark” type) text repeat for 

the number sign. (The result might be, for example, “To Coda fi.”) And if you place the “Go to 
Measure #” marking into the score, Finale will replace the number sign with the measure 
number to which you direct this marking’s playback. (The result might be, for example, “Go 
to Measure 44.”) (See REPEATS (BARLINES AND TEXT INDICATIONS) for a more complete dis-
cussion of these options.)

Ï

Key velocity 114

Î

Key velocity 127

Adagio Tempo 40

Moderato Tempo 80

Allegro Tempo 120

√

Transposition 12

◊

Transposition –12

accel. Tempo Increases 26 beats per 
minute over four beats

rit. Tempo Decreases 26 beats per 
minute over four beats

D.C. al Fine To Coda #

D.C. al Coda Fine

D.S. al Fine
fi

D.S. al Coda
%

D.S. al # Go to Measure #

Expression Playback effect Value
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Finale Score Templates
In your Finale folder, you’ll find a folder called Templates. In this folder you’ll find three dozen 
blank Finale documents, each with staves in a particular instrumental configuration. These tem-
plates can save you time—just open a copy of a score setup you need, and start entering the music. 
To open a template, choose File, New, then Document from Template.

These templates have the “.FTM” extension, which means that they will appear as “untitled” files 
when you open them. Choose New from Template from the File Menu. Any template files in the 
current folder will appear in the list. Double-click the template you want to use.

Each of these templates, like the Maestro Font Default file, has a selection of libraries already 
loaded. These include the Chord Suffix, Articulations, Shape Expressions, Text Expressions, Text 
Repeats, Allotments (medium), Quarter Tone, and Executable Shapes libraries. Each has also been 
defined to have sequential measure numbers, page numbers, and a sample title. Staves for the 
transposing instruments (e.g., clarinets, horns) have been set up to transpose automatically (see 
TRANSPOSING INSTRUMENTS). The templates are titled as follows:

     

General Templates

Template title System setup

Lead Sheet.FTM One staff

Lead Sheet (Jazz Font).FTM One staff, uses Jazz Font

Grand Staff.FTM Two staves (piano staff)

Big Note Bells.FTM One staff (enlarged), landscape orientation

Instrumental Solo w Piano.FTM Three staves (piano and a reduced-size solo staff)

Instrumental Duet.FTM Two staves

Instrumental Trio.FTM Three staves

Instrumental Quartet.FTM Four staves

Instrumental Quintet.FTM Five staves

Transpositions.FTM 31 staves

Band Templates

Template title System setup

Small Concert Band.FTM Nine staves

Full Concert Band.FTM 26 staves

Wind Ensemble.FTM 25 staves

Marching Band.FTM 21 staves, landscape orientation

Jazz Band.FTM 18 staves, landscape orientation

Jazz Band (Jazz Font).FTM 18 staves, landscape orientation, uses Jazz font

Woodwind Trio.FTM Three staves (Flute, Oboe, Bassoon)

Woodwind Quintet.FTM Five staves (standard woodwind quintet)

Woodwind Choir.FTM 12 staves
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Brass Trio.FTM Three staves (Trumpet, Trombone, French Horn)

Brass Quintet.FTM Five staves (standard brass quintet formation)

Brass Choir.FTM 12 staves

Brass Band.FTM 19 staves (British brass band)

Drum Corps.FTM 7 staves

Orchestral Templates

Template title System setup

String Trio.FTM Three staves (standard string trio)

String Quartet.FTM Four staves (standard string quartet)

String Orchestra.FTM Five staves

String Orchestra with Piano.FTM Seven staves

Chamber Orchestra.FTM 20 staves

Full Orchestra.FTM 27 staves

Choral Templates

Template title System setup

Barbershop Female.FTM Two staves (Sopr, Lead, Alto, Alto)

Barbershop Male.FTM Two staves (Tenor, Lead, Bari, Bass)

Vocal Solo with Piano.FTM Three staves (piano and vocal)

Two Part with Piano.FTM Four staves

SSA with Piano.FTM Five staves (SSA plus piano)

SAB with Piano.FTM Five staves (SAB plus piano)

SATB (Four Staff) with Piano.FTM Six staves (SATB plus piano)

SATB w Piano, Bass & Perc.FTM Eight Staves (SATB + 4)

TTBB w Piano.FTM Six staves (TTBB plus piano)

SATB (Two Staff) with Piano Four staves (SA on Treble, TB on Bass, plus piano)

Kodály.FTM Two staves - One for solfège, one for Stick notation

Kodály Auto-Stick Notation.FTM One staff for Stick notation

Church Templates

Template title System setup

Church Orchestra.FTM 19 staves

Handbells.FTM One staff

Hymnal.FTM Two staves

Piano & Organ.FTM Five staves (2 + 3)

Band Templates

Template title System setup
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Configuring Pagesizes.txt
The Setup Wizard, the Page Layout Tool and other parts of Finale use the pagesizes.txt file to 
determine the page size and margins of the score. You can edit this file to get a custom page size 
and margin. Make sure you save the file as text only.

[Page Sizes]
This section contains the page size name, Width and Height (followed by a semicolon), Top Mar-
gin, Bottom Margin, Left Margin, Right Margin, and a Left Margin for single-instrument docu-
ments. The Top and Bottom margins are assumed to be negative; there is no need to put in the 
minus sign.

Ex. Letter = 8.5, 11; .5, .5, 1, .5, .75

Configuring Instrument.txt
The Setup and Exercise Wizards use the instrument.txt file to determine what instruments to offer, 
what order from top to bottom to place the instruments and more.

To include musical characters from the default font, use ^flat() for a flat, ^sharp() for a sharp and 

^natural() for a natural. For example, to get a Bb Clarinet, you’d type B^flat() Clarinet.

[INS:Intrument]
These sections contain the detailed information for the particular instrument such as [INS:Flute].

Name =  Staff Name

Abbr = Abbreviated Staff Name

useKeySigs = Use Key Signature for staff and staff transposition (1= Use, 0= Don’t Use)

Transposition = Set the transposition with the number of half steps up or down 

(Examples: 12=octave up, 0 = none, -12 octave down)

TransClef = Type of clef for transposing instrument

(treble, bass, alto, treble8vb, percussion, tenor, baritone, bass8vb, 
frenchviolin, cbaritone, mezzosoprano, soprano, altpercussion, treble8va, 
bass8va, blank)

StaffType = Type of Staff (standard, percussion, single, grand, organ)

Clef = Type of Clef

(treble, bass, alto, treble8vb, percussion, tenor, baritone, bass8vb, 
frenchviolin, cbaritone, mezzosoprano, soprano, altpercussion, treble8va, 
bass8va, blank)

Patch = Patch Number for General MIDI based from 0-127.

Shape Note Hymnal.FTM Two staves with note shapes

Church Templates

Template title System setup
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PercMap = Percussion Map Name or single General MIDI note number.

Use quotes to enter the name of a percussion map, if it contains a number.

ExWizDisp = 1=Instrument will appear in the Exercise Wizard, 0=Instrument does not 
appear in the Exercise Wizard, but does appear in the Setup Wizard

RangeLow = Lowest note allowed in the Exercise Wizard in various skill levels: Basic, 
Intermediate, Advanced. (Values expressed as MIDI note numbers)

RangeHigh = Highest note allowed in the Exercise Wizard in various skill levels: Basic, 
Intermediate, Advanced. (Values expressed as MIDI note numbers)

[GRP:Group]
These sections define the group or family names.  These items will be grouped together using a 
bracket.

Name = Group Name

Abbr = Abbreviated Group Name

Instrument = x Instrument name (x = include in list, no x does not include in list)

ExWizDisp = 1=Group will appear in the Exercise Wizard, 0=Group does not appear in 
the Exercise Wizard, but does appear in the Setup Wizard

[ORD:Order]
This list contains the default order of the instruments in the wizard. As in the Group section, x 
means include the instrument; no x means do not include the instrument. If an instrument is not 
listed in the Order, it will be added to the bottom of the list.

Configuring Ensembles.txt
The Exercise Wizard uses the Ensembles.txt file to determine what make up an ensemble and 
what ranges to use. You can access all of these options within the Exercise Wizard.

[Ensemble Name]
This section contains the name of the ensemble.

InstNames= List of instruments in the ensemble

InstrCopies= Number of copies of each instrument. Corresponds to list of instruments 
above it, separated by commas

Range= Lists skill level to use for ensemble (1=Advanced, 2=Intermediate, 
3=Basic)
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Finale File Extensions
Finale creates a number of different types of files; each has its own extension. In the table below, 
you’ll find a description of each kind of file you may encounter while working with Finale.

File Extension Description How to Make One How to Open One

Finale.EXE
Finale application 
(program)

This is the Finale program itself There’s only one of these Double-click to start Finale.

.MUS
Finale file

This is a standard Finale (notation) 
document file.

Choose Save As from the File 
Menu.

Double-click.

.LIB
Finale library

A Finale library may contain a set 
of symbols (such as Chords or 
Articulations), markings (such as 
Text Expressions), or settings (such 
as Document settings or Spacing 
Widths

Choose Save Library from the 
File Menu.

From the File Menu, choose 
Open Library.

.LSN
Lesson file

This file contains a grouping of 
exercises and an ensemble of instru-
ments.

From the File Menu, choose 
New, Exercise Wizard.

From the File Menu, choose 
Open; select Lesson File and 
double-click the one you want 
to open.

.PLY
Playback file

This file contains playback informa-
tion for a document, including all 
playback settings and the effects of 
expression markings.

Choose Playback Controls 
from the Windows Menu; click 
the Playback Settings button. 
Click Save File, and then select 
the File Type “Playback File.”. 
Name the file and click OK.

Choose Playback Controls 
from the Window Menu; click 
the Playback Settings button. 
Click Select File and double-
click the Playback file you 
want to open.

.MID
MIDI file

This is a standard MIDI sequencer 
file. It can be read by most 
sequencer programs.

Choose Save As from the File 
Menu; select the File Type 
“MIDI File.” Name the file and 
click OK.

From the File Menu, choose 
Open; select MIDI File and 
double-click the one you want 
to open.

.TRK
Track/Staff Map-
ping file

This file contains sequencer track/
channel-to-Finale staff information 
for use when you open a MIDI 
sequencer file with Finale.

Choose Open from the File 
Menu; select the File Type 
“MIDI File.”, and double-click 
the one you want to open. 
Click Track-to- Staff List; cre-
ate a track/staff configuration 
and click Save. See TRACK/
CHANNEL MAPPING TO 
STAVES DIALOG BOX.

From the File Menu, choose 
Open; select the File Type 
“MIDI File.”, and double-
click the one you want to 
open. Click Track-to-Staff 
List and click Load. Double-
click the one you want to 
open.

.NOT
Note file

This file contains the MIDI infor-
mation you’ve recorded in the Tran-
scription window.

Click the HyperScribe Tool, 
select Transcription Mode and 
click a measure. Click Wait 
Till and perform your piece. 
Choose Save As from the file 
Menu. Name the file and click 
OK

Click the HyperScribe Tool, 
select Transcription Mode 
and click a measure. Choose 
Open from the File Menu. 
Double-click the Note file 
you want to open.
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.CLP
Clip File

This file contains a motif, passage, 
or section of music you’ve copied 
from a Finale document.

Click the Mass Mover Tool; 
select a region of measures. 
While pressing ctrl, choose 
Cut or Copy from the Edit 
Menu. Name the file and click 
OK. See COPYING MUSIC.

Click the Mass Mover Tool; 
select a region of measures. 
While pressing ctrl, choose 
Insert or Replace Entries from 
the Edit Menu. Double-click 
the Clip file you want to open.

.ETF
Enigma Transport-
able file

This is a text-only file that can be 
read by a word processor, or by 
Finale running on another kind of 
computer.

Choose Save As from the File 
Menu; select the File Type 
“ENIGMA Transportable 
File.” Name the file and click 
OK.

Choose Open from the File 
Menu; select the File Type 
“ENIGMA Transportable 
File”, and double-click the 
one you want to open.

.PS
PostScript file

This special text file contains the 
complete PostScript description of 
your document; by downloading it 
to a PostScript printer, you can print 
without using the Finale program 
itself.

Choose Compile PostScript 
Listing from the File Menu 
and click OK; name the file 
and click OK.

You can’t open these files. 
You need a special download-
ing program to send this file 
to the printer. See POST-

SCRIPT.

.EPS
Encapsulated Post-
Script file

This special text file contains the 
Encapsulated PostScript descrip-
tion of one page of your document. 
This file can be used in Finale or in 
other programs that import graph-
ics.

Choose Compile PostScript 
Listing from the File Menu or 
Export Page from the Graphics 
Menu or double-click to select 
an area and choose Export 
Selection from the Graphics 
Menu. Enter a page number in 
the “EPS file of page:” text box 
if needed, and click OK; name 
the file and click OK.

Select Place Graphic from the 
Graphics Menu or start 
another page layout or graph-
ics program and use its Open 
or Place command. Double-
click the name of the EPS file. 
Click in the score to place the 
EPS file.

.TIF
TIFF file

This graphic file contains a TIFF 
graphic which can be used in Finale 
or in other programs that import 
graphics.

Double-click to select an area 
to export in the Graphics Tool 
and select Export Selection 
from the Graphics Menu, or 
just select Export Pages from 
the Graphics Menu. Select 
TIFF from the Type drop-down 
list. Click OK

Select Place Graphic from the 
Graphics Menu or start 
another page layout or graph-
ics program and use its Open 
or Place command. Double-
click the name of the TIFF 
file. Click in the score to 
place the TIFF file.

Finale.INI
Preferences file

This is the Finale Preferences file, 
which contains settings such as 
those made in the Program Options 
dialog box and the Windows Menu.

Finale creates this file automat-
ically and places it in your 
Finale folder.

Finale uses this file each time 
the program is started.

.FXT
Plug-in applica-
tions

This a plug-in, which is a small pro-
gram that runs only in Finale to 
allow you to enhance Finale’s abili-
ties.

Finale comes with a number of 
plug-ins already installed in 
your Finale folder. If you are 
interested in making your own 
Plug-in programs please visit 
our website for details.

You can’t open these files. 
Finale loads all the plug-ins 
available each time the pro-
gram is started.

.PDF
Manual file

These are Acrobat® files which 
contain the Finale User Manual. 

These files are installed auto-
matically into your Finale 
folder.

Select any of the topics in the 
Manual submenu of the Help 
Menu. This will open the file 
using Acrobat® Reader

File Extension Description How to Make One How to Open One



Finale and Explorer A-17      

OC

OC

ndex

Index

revious
hapter

revious
hapter

ext 
hapter

ext 
hapter
T

T

I

P
C

P
C

N
C

N
CFinale and Explorer

Finale supports standard usage of Explorer in Windows 95/98/NT. In particular, “drag and drop” 
and command-line switches are supported.

Drag and drop
Drag and drop is supported for opening files. Start Finale and Explorer. In Explorer, select the 
Finale files you wish to open. Drag them to Finale's window and release the mouse button. The 
selected files will be opened in Finale. Finale also supports printing from Explorer: see your Win-
dows documentation for details.

Project icons
You can create Finale icons in the Program Manager for different projects. This feature can be 
used to specify groups of files such as a score, and all extracted parts of a score. Use icons in con-
junction with the command-line switches below, specifying different sets of files and perhaps an 
alternate Finale.INI file, to customize your Finale working environment.

Command line
Finale supports multiple filespecs and wildcards in the command line of a Program Manager icon. 
For example, specifying “*.mus” on the command line will open all the music files in the current 
folder. Finale also supports the following command-line switches. These switches can appear in 
any order, anywhere in the command line. They are not case sensitive, and can be combined. 
Either “-” or “/” acts as a switch trigger. Some command switches can be accessed more easily 
from the PROGRAM OPTIONS DIALOG BOX, such as whether to open a document on startup.

-q Instead of launching Finale and displaying an “Untitled” document, it displays the 
Open dialog box and prompts for the file you want to open. The Open dialog box 
appears once for each “q” switch in the command line.

-n Launches Finale without loading the MIDI drivers. This can be useful if you are 
running other MIDI software, or if there is some other MIDI-related problem on your 
system.

-x Launches Finale without opening any documents, not even a default “Untitled” 
document.

.TMP
Finale Temporary 
file

This is one of Finale’s temporary 
files; under normal circumstances, 
you never see them.

The temporary file exists only 
while your working in Finale 
(or after the computer is turned 
off without quitting Finale 
properly).

You can’t open these files.

.BAK This is a backup of a standard nota-
tion document file.

These files are created when 
Make Backups When Saving 
Files is selected in the Program 
Options dialog box.

In Finale, choose File, then 
Open. Select Files of Type, 
All Files. Double-click on the 
file.

.ASV This is an automatically saved 
backup of a standard notation docu-
ment file.

These files are created when 
Auto Save Files Every X Min-
utes is selected in the Program 
Options dialog box.

In Finale, choose File, then 
Open. Select Files of Type, 
All Files. Double-click on the 
file.

File Extension Description How to Make One How to Open One
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-z Launches Finale without any Plug-ins. The Plug-in Menu will not appear.
-i Lets you specify an alternate Finale.INI file. Enter the file name of the INI file you 

want Finale to draw its settings from. This can be very useful if you share your 
computer with someone else, or if you have different projects that require different 
global settings.

-p Prints the first file on the command line.
Examples:

Finale -qn

Starts Finale without MIDI and prompts for a file name.

Finale pr1\*.mus -i Finale.pr1

Opens all the files in the PR1 folder, and uses the settings in Finale.PR1 instead of Finale.INI.

About the Finale.INI file
The Finale.INI file contains custom settings and Finale Preferences that you set within the Finale 
program. Finale Preferences include dialog boxes and menu settings that affect your Finale work-
ing environment. They do not include settings that differ from document to document. Most of the 
options in the Finale.INI can and should be set within the Finale program itself. Other settings can 
only be changed in the Finale.INI file. For example, you may need to change the font used for 
Finale's Message Bar, depending on the fonts installed in your system.

The Finale.INI file can be edited with a text editor such as NotePad. In general, you will not need 
to edit this file directly. Do not edit the Finale.INI file while Finale is running. 

If you choose to edit the Finale.INI file, be sure to make a backup of it first! If you make an 
accidental change, you can either restore the backup copy of the Finale.INI file, or delete the 
edited Finale.INI file. When you launch Finale again, Finale will re-generate a new Finale.INI. If 
Finale creates a new Finale.INI file, any custom settings and Finale Preferences you had saved in 
your previous INI file will be lost.

The Finale.INI file is divided into sections, which are separated by headers that appear in square 
brackets. The Finale.INI consists of the following sections:

[Settings]
[MIDI]
[Extensions]
[Program Options]
[Colors]
[Chromatic Spelling Tables]
[Palettes]
[Speedy Keys]
[Directories]

The following paragraphs contain general descriptions of each Finale.INI section, as well as an 
explanation of the settings within the section. Each setting contains a more detailed explanation, 
and is marked either Set in Finale, Optional, or Do not edit. The default values are also listed for 
each setting. If a key is not found in the Finale.INI file, then the default value will be assumed. 
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Settings that are marked “Do not edit” should ordinarily be left alone. Edit such settings only if 
you are having a particular problem and you know exactly what you are doing!

[Settings]
This section includes general settings that can enhance your Finale working environment.

Init=(0, 1)

Do not edit. The default is 0, which indicates that Finale has never been run on this system. Finale 
sets the Init value to 1 the first time it launches, and allows you to personalize your copy of Finale 
by entering your name and serial number.

MusicFontName=Maestro
MusicFontSize=24
Set in Finale. Reflects the default music font and size that you specify in the Select Default Fonts 
dialog box.

HandleSizeX=0
HandleSizeY=0
Optional. When set to 0, Finale displays handles on editable music elements using a default size. 
You may want to change these values (which are measured in pixels) if the handles are either too 
large or too small. For example, if you set your monitor to a high resolution, the handles that 
Finale displays may be too large in relation to the elements in your score. In this instance, the han-
dles may completely obscure an element such as a staccato marking.

IncludeFonts=(0, 1, 2)

Set in Finale. Use the Include Fonts checkbox in the Compile PostScript dialog box to turn this 
setting on (1) and off (0). If you're having problems with this value set to 1, try changing it to 2.

When set to the default value of 1, Finale includes fonts when compiling PostScript listings. If 
Finale cannot find the soft font listing in the WIN.INI file, it asks the PostScript driver for fonts. 
When set to 2, Finale includes only the soft fonts listing from the WIN.INI file when compiling 
PostScript listings. If Finale cannot find the soft font listing, it will not ask the PostScript driver 
for fonts. If the resultant PostScript files are too large, you can change this setting to 0. When set 
to 0, the fonts will not be included in the PostScript listing. This results in much smaller files, but 
requires you to manually download the fonts prior to printing the files. 

MaxPSFontsPerPage=15

Do not edit. This setting controls the number of fonts that will fit into your printer's virtual mem-
ory. Although a higher number may result in faster printing, it may also increase the risk of Post-
Script errors.

PSXResolution=
PSYResolution=
Do not edit. Finale gathers its default settings from the printer driver. These settings control the 
resolution of coordinates in PostScript files and printing.

MsgBarHeight=0

Optional. Defaults to 0. If set to 0, the height is automatically calculated from the MsgBar-
FontHeight and MsgBarBorder settings. Otherwise, Finale uses the height (in pixels) you specify.

MsgBarBorder=3
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Optional. Defaults to 3 pixels. The border is contained within the MsgBarHeight.

MsgBarFontHeight=0

Optional. Defaults to 0. If set to 0, the Message Bar font will be 10 pixels high. If you need to 
change the size of the message bar font, enter the value in pixels. For example, if you enter 12, the 
font will be 12 pixels high, and the Message Bar height adjusts to the specified size. Hint: Sizes 
between 8-12 work best.

MsgBarFont=

Optional. Defaults to no specific font, so that Finale displays a sans serif font provided by Win-
dows. Enter the exact font name (as it appears in the Fonts control panel) that you want Finale to 
use for the Message Bar display. Example: “MsgBarFont=Arial”.

MsgBarTop=(0,1)

Optional. Defaults to 0, so the Message Bar appears at the bottom of Finale's main window. If you 
want the Message Bar to appear at the top of Finale's main window, change this to 1.

MsgBarShow=(0,1)

Set in Finale. Choose Message Bar from the Windows Menu. Defaults to 1 so that the Message 
Bar appears in Finale. If this is set to 0, Finale's Message Bar will not appear.

ShowRulers= (0,1)

Set in Finale. Choose Show Rulers from the View Menu. Defaults to 1 so that the rulers appear 
on-screen in Finale. If this is set to 0, the rulers will not appear.

MaxFileAlert=10

Optional. Defaults to 10. This determines the maximum number of files that can be opened before 
a warning appears. You can open more than one file at a time, by using the command line, or by 
using the drag and drop feature in the File Manager. When the warning appears, you can choose to 
continue to open the files, but you may run into memory limitations. This guards against acciden-
tally opening dozens or hundreds of files.

LoadWinPos=0
SaveWinPos=0
Set these options in Finale. Use the Program Options dialog box to determine what will be saved. 
They refer to the following settings: Load Window States at Startup, Save Window States at Exit.

MaximizeWin=0
WinPos=(left) (top) (right) (bottom)
Do not edit. These settings are controlled by the LoadWinPos and SaveWinPos. MaximizeWin 
determines the state of the window: 0 = normal, 1 = maximized, 2 = minimized. WinPos deter-
mines the position of the main window. If you want to alter the positioning of your windows, posi-
tion the windows in Finale, and use the Program Options dialog box to Save or Load the window 
positioning.

SerifFont=
SansSerifFont=
Optional. Default serif font is “Times New Roman.” The default sans serif font is “Arial”. These 
fonts are used for any text elements that you can't set the default fonts for within Finale. The 
default fonts for the majority of text elements in Finale are controlled in the Select Default Fonts 
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dialog box (Options Menu). If the specified font is not available, Windows provides an alternative 
font.

OPoolSize=1560
DPoolSize=1489
EPoolSize=511
Optional. These settings control the size of Finale's internal data caches. They replace Finale 3.0's 
OtherPoolSize, DetailPoolSize and EntryPoolSize settings. If you adjusted these settings for 
Finale 3.0, you may wish to modify them for Finale 3.5, especially if you have a slower machine. 
However, the recommended values are considerably higher than the old values.

NewWinMax=(0,1)

Set this option in Finale. Use the Other Program Options dialog box to select whether new win-
dows will be maximized or not.

IndependentPSPages=(0,1)

Optional. Defaults to 1. The standard setting of 1 is compatible with print spoolers, but results in 
larger PostScript files. We recommend setting it to 0 to reduce the size of the PostScript file, and 
to reduce the number of times a font is downloaded. If 0, printer memory will not be reset after 
each page in compiled PostScript files. The resulting file will not be “Adobe conforming,” mean-
ing that it might confuse some spoolers, but will download more rapidly. (This setting is equiva-
lent to the Advanced Option, “Clear Memory Per Page” in the Windows PostScript driver setup 
dialog box.)

FontScaleMode=(0,1,2)

Optional. Defaults to 0. This setting determines how bitmap fonts are rendered when an exact 
match cannot be found. If 0, Finale will try to scale the bitmaps. If 1, Windows will scale the bit-
maps. If set to 2, Windows will substitute the “closest” TrueType font. Setting this option to 1 or 2 
will avoid potentially long printing times to non-PostScript printers. 

NewWinPerc=100

Set this option in Finale. Use the Other Program Options dialog box to select what view percent-
age will be used in new windows.

NewWinScroll=1

Set this option in Finale. Use the Other Program Options dialog box to select whether new win-
dows will be opened in Scroll View or Page View.

Use3D=1

Optional. Defaults to 1. If 0, CTL3DV2, which displays three-dimensional buttons, is disabled. 
This is ordinarily set automatically by Finale if it detects an incompatibility or failure of 
CTL3DV2, but can be set to 0 by the user if required.

OpenOlderDocsAsUntitled=

OpenTemplatesAsUntitled=

Set these options in Finale. Use the Other Program Options dialog box to select whether older 
documents and Templates will be opened as untitled documents.



About the Finale.INI file A-22      

OC

OC

ndex

Index

revious
hapter

revious
hapter

ext 
hapter

ext 
hapter
T

T

I

P
C

P
C

N
C

N
C

ConfirmConversion=

Set this option in Finale. Use the Other Program Options dialog box to select whether Finale will 
ask about converting ties to PostScript or screen representation in when opening older files.

UndoPastSave=

Set this option in Finale. Use the Other Program Options dialog box to select whether Undo will 
take effect past the Save operation.

TaskDoneChime=

Set this option in Finale. Use the Other Program Options dialog box to select whether a chime will 
sound when a long Mass Mover task is completed.

DMCS=2

Set this option to force two-byte (1) or single-byte (0) font support. The default it 2, which will 
auto-detect which to support based on your system font.

OwnPS=3

Optional. Set this option to zero to have Windows generate the Postscript for the text and Finale 
generate the Postscript for the graphics. This setting works better for some situations, such as 
printing imported EPS graphics, but requires an Optimize for Portability setting on your printer 
driver. Set this option to 3 to have Windows generate the Postscript for both the text and the graph-
ics. Default settings is 3.

[MIDI]
MIDIRoot=FINMIDI

Do not edit. This entry stores the name of Finale's own MIDI driver. It should never be changed.

MIDIEcho=0
MIDISendSync=0
MIDIEcho0=0 1 2 3 4 5 6 7 8 9
MIDIEcho10=10 11 12 13 14 15 16 17 18 19
MIDIEcho20=20 21 22 23 24 25 26 27 28 29
MIDIFixedEchoChannel=0
All of these settings are set within Finale by choosing MIDI Sync and MIDI Thru from the MIDI 
Menu.

[Extensions]
This section contains optional settings that control the extensions Finale uses for its files. You 
should only make changes if you have a conflict with another application. Note that the extensions 
do not include a period. The Backup extension supports the standard DOS wildcards “*” and “?”. 
For example, “Backup=??_” will save backup files with the first two characters of the original 
extension followed by an underscore. If you choose to set a backup folder (see “BackupDir” 
below), you may want to have backup files retain their original extensions. In this case you would 
use “Backup=*”.

Music=MUS
Template=FTM
ETF=ETF
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MIDI=MID
Playback=PLY
Transcription=NOT
Postscript=PS
Library=LIB
Clip=CLP
Backup=BAK
Encapsulated PostScript=EPS
TIFF=TIF
Windows Metafile=WMF
Track=TRK
AutoSave=ASV
PlugIn=FXT

[Program Options]
This section contains performance settings that are controlled in, or related to the Program 
Options dialog box.

Purge=(0,1)

Optional. Defaults to 0. Finale does not clean out Temp files when you close files. Although this 
helps Finale to run faster, if you open or close a lot of files, you could potentially run out of disk 
space. If you have limited disk space you may want to set this to 1 so that Finale cleans out the 
Temp files when you close a file. You will notice that Finale takes longer to close files. Turning 
Undo on and off will also purge unneeded temporary files.

DottedRests=(0,1)

Set in Finale. Defaults to 0, which means that dotted rests are not allowed during transcription. If 
you set it to 1, dotted rests are allowed during transcription.

DefaultFile=Maestro Font Default.FTM

Set this option in Finale. Use the Other Program Options dialog box to change the default file 
name from Maestro Font Default to another name.

g0=0 0 0 0 0 0 0 0 0 0
g10=0 0 0 0 0 0 0 0 0 0
Do not edit. These settings are controlled by the Program Options dialog box.

MaxProgOpts=266

Do not edit. This setting is controlled by the Program Options dialog box.

SavePrefs=1

Set in Other Program Options. Defaults to 1, which means that preferences are saved when exiting 
Finale.

ToolMenu=0

Set in Other Program Options. Defaults to 0, which means that the Tool Menu is not displayed.
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[Colors]
UseColor=1
UseLayerColor=0
c1= 
...
cc16=
Set these options within Finale by choosing Select Display Colors from the View Menu.

[Chromatic Spelling Tables]
ChromCount=36
ChromMode=0
g0=0 1 0 1 0 0 0 0 1 0
g10=1 0 0 1 0 0 0 0 0 0
g20=0 0 0 0 0 0 0 0 0 0
g30=0 0 0 0 0 0 0 0 0 0
Set these options within Finale by using the commands in the Option Menu's Enharmonic Spell-
ing submenu.

[Palettes]
This section contains positioning and tool arrangement for the palettes in Finale. Most of these 
settings are saved when Save Window States at Exit is selected in the Program Options dialog 
box.

AutoClosePalettes=(0,1)

Set in Finale. Defaults to 1, so Finale closes the sub-palettes when you select another tool on the 
Main Tool Palette. When set to 0, the palettes remain on the screen when you select another tool 
on the Main Tool Palette.

MainPalette=(on) (current tool idx) (anchor) (left) (top) (width) (height)
SimplePalette=(on) (current tool idx) (anchor) (left) (top) (width) (height)
SmartPalette=(on) (current tool idx) (anchor) (left) (top) (width) (height)
SpecialPalette=(on) (current tool idx) (anchor) (left) (top) (width) (height)
Do not edit. These settings store the position and configuration of the tool palettes. The one value 
that can be edited within Finale is (anchor), which defaults to 0. This value governs where the pal-
ette is positioned relative to, according to the following chart:

When 
anchor is

Palette is positioned relative to

0 top left of application window

1 top right of application window

2 bottom left of application window

3 bottom right of application window

4 top left of screen
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TS1.0=(list of space -- delimited tool IDs -- for tool set 1)
TS1.1=(continued)
TS2.0=(list of space -- delimited tool IDs -- for tool set 2)
TS2.1=(continued)
TS3.0=(list of space -- delimited tool IDs -- for tool set 3)
TS3.1=(continued)
Do not edit. These settings store the configuration for Finale's tool sets.

[Directories]
This section includes settings that are controlled in the Program Options dialog box.

MusicDir=
LibDir=
BackupDir=
AutoSaveDir=
ExtensionDir=
TemplateDir=
DocuDir=
TempFileDir=
Set in Finale. Use the Program Options dialog box to specify the folders.

About the FINMIDI.INI file
The FINMIDI.INI file is created when you confirm your MIDI Setup (Options Menu). All settings 
except the playback interrupt value (“MMESpeed”) are controlled in Finale's MIDI Setup dialog 
box.

[FINMIDI]
MMESpeed=4

Optional. Defaults to 4. This value seldom needs to be edited. It controls the amount of millisec-
onds between playback interrupts. If you have a slower computer, you may want to increase this 
value to improve the playback performance. Note that the difference is very minimal. If you have 
a faster machine, you probably won't hear a difference at all.

[MMEDRVR]
MidiOutReset=0
SyncMaster=0
Set in Finale. These settings correspond to the checkboxes in the MIDI Setup dialog box.

5 top right of screen

6 bottom left of screen

7 bottom right of screen

When 
anchor is

Palette is positioned relative to
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InName1=
InBase1=
...
OutName1=
OutBase1=
OutMatch1=
...
Do not edit. Controlled in the MIDI Setup dialog box. The only values you may need to edit are 
the “OutMatch” settings. They default to 1, which means that each note on is matched up to a note 
off, even if it's the same pitch. You may need to edit this if your MIDI device cuts off all identical 
notes when the first note off is received. The Gravis Ultrasound exhibits this behavior; there may 
be other devices that behave similarly. Normally each note off is matched by a note on.

Customized Speedy Keymap
This section describes how to install a customized Speedy keymap for German and Swiss-German 
keyboards for Finale for Windows. The techniques can also be used for other international key-
boards. Installing the customized keymap requires editing your Finale.INI file directly. Please use 
caution when editing Finale.INI. Follow the warnings and instructions below.

 The Finale.INI file can be edited with a text editor such as Notepad. If you use a word processor 
(such as Word), be sure to save the file as “text only with line breaks”. Do not edit the Finale.INI 
file while Finale is running.

If you choose to edit the Finale.INI file, be sure to make a backup of it first. If you make an 
accidental change, you can either restore the backup copy of the Finale.INI file, or delete the 
edited Finale.INI file. When you launch Finale again, Finale will re-generate a new Finale.INI. If 
Finale creates a new Finale.INI file, any custom settings and Finale Preferences you had saved in 
your previous INI file will be lost.

If you have any doubts about how to edit Finale.INI, don't do it! Mistakes can cause you to lose 
your Finale settings, and perhaps cause Finale to run improperly. This is why a backup copy of the 
file is so important.

The German Keymap
You will need to replace the entire [SpeedyKeys] section of Finale.INI, including the line 
“[SpeedyKeys]” as well as all subsequent lines beginning with “SK”. Replace the [SpeedyKeys] 
section with the new [SpeedyKeys] section below. If the [SpeedyKeys] section does not exist in 
your Finale.INI, simply add the new section below.

This keymap adopts the standard Speedy Entry commands for German and Swiss-German key-
board layouts. In addition, Swiss-German users can now use the '$' key to change layers (instead 
of the '#' key).

[SpeedyKeys]

SK000=59 0 -1 -1 -1 5

SK001=65549 0 0 -1 -1 34

SK002=65582 0 -1 -1 -1 23
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SK003=65544 0 0 -1 -1 24

SK004=65574 0 0 -1 -1 15

SK005=65574 0 1 -1 -1 11

SK006=65576 0 0 -1 -1 16

SK007=65576 0 1 -1 -1 12

SK008=65573 0 0 -1 -1 13

SK009=65573 0 1 -1 -1 9

SK010=65573 1 0 -1 -1 17

SK011=65575 0 0 -1 -1 14

SK012=65575 0 1 -1 -1 10

SK013=65575 1 0 -1 -1 18

SK014=91 0 -1 -1 -1 9

SK015=93 0 -1 -1 -1 10

SK016=65563 0 0 -1 -1 82

SK017=39 0 -1 -1 -1 6

SK018=35 0 -1 -1 -1 8

SK019=65725 0 1 -1 -1 25

SK020=65725 1 1 -1 -1 26

SK021=65723 0 0 -1 -1 19

SK022=65723 1 0 -1 -1 21

SK023=65725 0 0 -1 -1 20

SK024=65725 1 0 -1 -1 22

SK025=65643 0 -1 -1 -1 19

SK026=65643 1 -1 -1 -1 21

SK027=65645 0 -1 -1 -1 20

SK028=65645 1 -1 -1 -1 22

SK029=65642 0 -1 -1 -1 28

SK030=65642 1 -1 -1 -1 29

SK031=47 0 -1 -1 -1 27

SK032=46 0 -1 -1 -1 33

SK033=65723 0 1 -1 -1 28

SK034=65723 1 1 -1 -1 29

SK035=65615 0 -1 -1 -1 1

SK036=65616 0 -1 -1 -1 2

SK037=65612 0 -1 -1 -1 3

SK038=65612 1 -1 -1 -1 4
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SK039=65584 0 0 -1 -1 81

SK040=65584 1 0 -1 -1 39

SK041=65585 0 0 -1 -1 40

SK042=65585 0 1 -1 -1 49

SK043=65585 1 0 -1 -1 83

SK044=65586 0 0 -1 -1 41

SK045=65586 0 1 -1 -1 50

SK046=65586 1 0 -1 -1 84

SK047=65587 0 0 -1 -1 42

SK048=65587 0 1 -1 -1 51

SK049=65587 1 0 -1 -1 85

SK050=65588 0 0 -1 -1 43

SK051=65588 0 1 -1 -1 52

SK052=65588 1 0 -1 -1 86

SK053=65589 0 0 -1 -1 44

SK054=65589 0 1 -1 -1 53

SK055=65589 1 0 -1 -1 87

SK056=65590 0 0 -1 -1 45

SK057=65590 0 1 -1 -1 54

SK058=65590 1 0 -1 -1 88

SK059=65591 0 0 -1 -1 46

SK060=65591 0 1 -1 -1 55

SK061=65591 1 0 -1 -1 89

SK062=65592 0 0 -1 -1 47

SK063=65592 1 0 -1 -1 90

SK064=65592 0 1 -1 -1 56

SK065=65593 1 0 -1 -1 32

SK066=65593 0 0 -1 -1 31

SK067=65632 0 -1 -1 -1 81

SK068=65632 1 0 -1 -1 39

SK069=65633 0 -1 -1 -1 40

SK070=65633 1 -1 -1 -1 83

SK071=65634 0 -1 -1 -1 41

SK072=65634 1 -1 -1 -1 84

SK073=65635 0 -1 -1 -1 42

SK074=65635 1 -1 -1 -1 85
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SK075=65636 0 -1 -1 -1 43

SK076=65636 1 -1 -1 -1 86

SK077=65637 0 -1 -1 -1 44

SK078=65637 1 -1 -1 -1 87

SK079=65638 0 -1 -1 -1 45

SK080=65638 1 -1 -1 -1 88

SK081=65639 0 -1 -1 -1 46

SK082=65639 1 -1 -1 -1 89

SK083=65640 0 -1 -1 -1 47

SK084=65640 1 -1 -1 -1 90

SK085=65641 0 -1 -1 -1 31

SK086=65641 1 -1 -1 -1 32

SK087=65609 0 -1 -1 -1 57

SK088=65611 0 -1 -1 -1 58

SK089=65724 0 0 -1 -1 59

SK090=65625 0 -1 -1 -1 60

SK091=65624 0 -1 -1 -1 61

SK092=65603 0 -1 -1 -1 62

SK093=65622 0 -1 -1 -1 63

SK094=65602 0 -1 -1 -1 64

SK095=65614 0 -1 -1 -1 65

SK096=65613 0 -1 -1 -1 66

SK097=65601 0 -1 -1 -1 67

SK098=65619 0 -1 -1 -1 68

SK099=65604 0 -1 -1 -1 69

SK100=65606 0 -1 -1 -1 70

SK101=65607 0 -1 -1 -1 71

SK102=65608 0 -1 -1 -1 72

SK103=65610 0 -1 -1 -1 73

SK104=65617 0 -1 -1 -1 74

SK105=65623 0 -1 -1 -1 75

SK106=65605 0 -1 -1 -1 76

SK107=65618 0 -1 -1 -1 77

SK108=65620 0 -1 -1 -1 78

SK109=65626 0 -1 -1 -1 79

SK110=65621 0 -1 -1 -1 80
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SK111=65646 0 0 -1 -1 33

SK112=65759 0 0 -1 -1 8
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Plug-in filenames
Plug-in Name

(as shown in Plug-in Menu)
Filename

Add Cue Noes Cuenotes.FXT

Align/Move Dynamics TGToolsLE2002.FXT

Auto-Dynamic Placement Autody32.FXT

Automatic Barlines Autobr32.FXT

Automatic Tablature Atab32.FXT

Band-in-a-Box Auto-Harmonizer BIABAutoHarmonizer.FXT

Canonic Utilities Seruti32.FXT

Cautionary Accidentals Ctnacc32.FXT

Change Font Chngfnt.FXT

Change Noteheads ChangeNoteheads.FXT

Change to Default/Real Whole Rests DefaultRests.FXT

Check Range Chkrng32.FXT

Check Region for Durations CHKDUR32.FXT

Chord Morphing ChordMorphing.FXT

Chord Realization ChordRealization.FXT

Chord Reordering ChordReordering.FXT

Chord Splitting ChordSplitting.FXT

Classic Eighth Beams CEBeams.FXT

Clear Lyric Positioning ClearLyricPos.FXT

Clear Measure Number Positioning MeasNumPos.FXT

Command Line CommandLine.FXT

Common Tone Transposition CommonToneTransp.FXT

Count Items Cntitm32.FXT

Create Tempo Marking Tmpmrk32.FXT

Easy Harmonics TGToolsLE2002.FXT

Easy Measure Numbers MEASNU32.FXT

Easy Repeats Repts32.FXT

Easy Tremolos TGToolsLE2002.FXT

Extract Lyrics lextract.FXT

Find Parallel Motion ParallelMotion.FXT
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Find Range Fndrange.FXT

First Ending Repeats Repts32.FXT

Flat Beams / Flat Beams Remove flatbm.FXT

Frequency Modulation Chord Generator FMChordGenerator.FXT

Global Staff Attributes Gstfatt.FXT

Ledger Lines - Hide & Show Hsledg32.FXT

Melodic Morphing MelodicMorphin.FXT

Menu Shortcuts TGToolsLE2002.FXT

Midline Stem Direction MidlineStemDirections.FXT

Move Rests MoveRests.FXT

Notes and Rests - Hide & Show flatbm.FXT

Number Repeated Measures NUMRPT32.FXT

Patterson Beams PatBeams.FXT

Piano Reduction PianoReduction.FXT

Rhythm Generator RhythmGenerator.FXT

Rhythmic Subdivisions RHYTHS32.FXT

Single Pitch SinglePitch.FXT

Slash Flagged Grace Notes (Remove) flatbm.FXT

Smart Playback TGToolsLE2002.FXT

Split Point MoveSplitPoint.FXT

Tie Common Notes TieCommonNotes.FXT

Virtual Fundamental Generator Virtfund.FXT

Voice 2 to Layer Voice2toLayer.FXT

Word Extensions (v2.0) WORDEX32.FXT

Word Extensions (Remove) RmWExt32.FXT

Plug-in Name
(as shown in Plug-in Menu)

Filename
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Finale Notational Defaults
Finale adheres to the standards of music engraving practice that follow. There are many more 
“rules” or “standards” that govern music notation, and indeed, the standards themselves may vary 
from publisher to publisher. The ones listed here are automatically supported by Finale.

Placement of Text
Staff names are centered vertically on each staff. Both full and abbreviated staff names are right-
aligned.

Chord symbols are placed 1/2 inch above the top line of the staff. If Guitar Fretboards also appear, 
the Chord Symbol appears one inch above the top line of the staff, and the top of the fretboard 
appears 1/2 inch above the top lines of the staff.

Lyrics appear 1/2 inch below the bottom line of the staff.

Notes, Stems and Beams (Ligatures)
Single notes with single stems are stemmed down when the note is positioned on the middle line 
of the staff or higher. Down stems are positioned on the left side of the note. Single notes with sin-
gle stems are stemmed up when the note is positioned on the second space of the staff or lower. 
Up stems are positioned on the right side of the note.
Single stems are exactly one octave in length. If there is more than one note on a stem, the stem 
length is calculated from the note closest to the end of the stem.
Stems of notes on ledger lines which would not normally reach the middle line of the staff are 
extended to reach the middle line of the staff.
A beam is the thickness of half a space. The normal stem length will accommodate two beams. 
For each additional beam the stem length is extended one space. The angle up or down of any 
beam does not exceed one space, and the direction of the slant is determined by the general direc-
tion of the movement of the notes.

Placement of Note Heads
In an interval of a second on a single stem the lower note is placed on the left of the stem, the 
upper note on the right. In this configuration the note head on the wrong side of the stem is called 
a “displaced” note. Chords with opposite stems or on separate staves are aligned according to the 
properly placed note heads, not the displaced note heads.

Accidentals in a chord
When accidentals cannot be aligned, the highest accidental is placed in the normal position and 
the next lower accidental is placed to the left of it. Accidentals continue to be placed to the left 
until an accidental can align with the top one, in which case the procedure is repeated until all the 
accidentals have been placed.

˙

˙
˙

b

œ

œ

œ

œ
œ

#

#
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Accidentals across barlines
When a note with an accidental is tied across a barline, the accidental is not repeated on the first 
note of the next measure. However, if the note appears later in the measure, the accidental is 
repeated.

Modifying Symbols
Articulations are placed on the notehead side, opposite the stem. Bowing marks are placed above 
the staff, regardless of the stem direction.

Music Spacing (Time Spacing)
There are no absolute rules governing time spacing, but Finale follows the general principle of 
spacing notes according to their duration. Longer notes are followed by larger spaces than shorter 
notes.
Bar lines have no rhythmic significance and do not affect the time spacing. Neither do accidentals, 
except in those situations when the normal time spacing may not allow enough room for the acci-
dental, in which case additional space is allotted for the accidental.
Rests are treated the same as notes, except for the whole measure rest which is centered in the 
measure.

Grace Notes
The stem direction is up for grace notes. Slashes appear on flagged grace notes (unless Slash 
Flagged Grace Notes is deselected in the Document Options dialog box).

Tuplets
Tuplets appear as a number placed within a bracket. The beam of a rhythmic group is extended 
over any rests within the group.

Multimeasure Rest (Block Rest)
A Multimeasure or block rest is built into Finale. The rest appears centered on the middle staff 
line. The thick horizontal line in 3 pts. (1 space) thick (the same thickness as beams), and the thin 
vertical lines, which extend from the second to the fourth staff line, are 1/2 point thick.

The multimeasure rest number appears just above the staff. The width of the measure is 1 1/4 
inches to contain the multimeasure rest symbol.

Line Thickness
Beam thickness is three points (half a space). Barline, ledger line, staff line, and stem line thick-
ness are half a point. Other lines (such as tuplet and repeat brackets) are also half a point thick.

Spacing of Basic Elements
A certain amount of space appears before and after basic musical elements. One space appears 
before clefs, key and time signatures, and before the first note or rest in a measure. An additional 
half space appears after key and time signatures.

Maestro Font Default file
The Maestro Font Default file consists of one treble staff with 21 measure, in common time. Mea-
sure numbers appear at the start of each line, above the clef. It contains libraries for music spac-
ing, chord symbols, musical text and shape expressions, articulations, and so on. See FINALE 
LIBRARIES for more information.
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The page size is 8.5 by 11 inches with 1/2 inch page margins all around except for the left margin 
which is 3/4 inch. The first system is indented (from the page margin) 1/2 inch, and is dropped 1 
1/2 inches to allow for a title, and other text. A place holder for a title appears centered 1/2 inch 
below the top margin, and page numbers appear beginning on page 2 in the form “-2-”. Music 
appears and prints at 85%.

Equivalents
This table gives equivalents for EVPUs, spaces, inches centimeters, millimeters, points, and picas. 
(There are 288 EVPUs - ENIGMA Virtual Page Units - per inch. A space is the music engraver’s 
unit of measurement - the distance between two staff lines.)

Finale also uses its own units of rhythmic, or durational, measurement: EDUs, or ENIGMA Dura-
tional Units. There are 1024 EDUs per quarter note. The following table provides EDU equiva-
lents for use on those occasions when you need to perform conversions of rhythmic value into 
EDUs in Finale.

EVPUs Spaces Inches CM MM Points Picas

24 1 .083 .212 2.12 6 .667

1 .042 .0035 .009 .09 .25 .042

288 12 1 2.54 25.4 72 6

113 4.708 .392 1 (.997) 10 28.25 2.3622

11 .458 .038 .1 (.097) 1 2.75 .2362

4 .167 .014 .035 .35 1 .083

48 2 .167 .423 4.23 12 1

Rhythmic value EDUs Rhythmic value EDUs Rhythmic value EDUs

double whole 8192 quarter 1024 dotted 32nd 192

dotted whole 6144 dotted eigth 768 triplet sixteenth 171

whole 4096 triplet quarter 683 32nd 128

dotted half 3072 eighth 512 dotted 64th 96

half 2048 dotted sixteenth 384 64th 64

dotted quarter 1536 triplet eighth 341 dotted 128th 48

half note triplet 1365 sixteenth 256 128th 32
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Edit Frame dialog box
How to get there

Click the Speedy Entry Tool a and ctrl-click a measure that contains music.

What it does
You’ll rarely, if ever, need to enter this extremely technical dialog box. It lists dozens of coded 
variables regarding the notes in the measure you clicked, and allows you to edit the “behind-the-
scenes” raw data Finale associates with each note. 

Each note in a measure has a good deal of information stored with it, including its ID number, its 
voice assignment, whether or not it “launches” a tie, and so on; in this dialog box, you can set 
each such “bit” manually. You’ll encounter some technical terms in this discussion; one of the 
most important is entry, which refers to any note, rest, or chord.

You can hide ledger lines on an entry by deselecting the Ledger checkbox in the Frame dialog 
box. There is also a Slur checkbox that indicates whether a slur is attached to an entry.
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• Frame (#). This indicator identifies the measure frame you’re editing. A frame refers to one 
measure in one staff. You should note, however, that Finale doesn’t number the frames in the 
order they occur in the score—instead, it numbers them in the order in which you created 
them.

• First Entry: (#) • Last Entry (#). These indicators identify the note or rest that begins and 
ends the measure you’re editing. Finale assigns a number to every single note or rest as you 
create it. While Finale assigns numbers to notes sequentially, you might not always enter notes 
sequentially, so the Start and End numbers may appear to be out of order.

• Current Entry (#). This indicator identifies the entry you’re looking at. (Remember that 
Finale gives every note or rest an ID number as you create it.)

• Duration. The number in this text box sets the rhythmic value of the current entry, in EDUs 
(1024 per quarter note). Click Duration if you want to change its value graphically; a palette 
of rhythmic values appears.
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• Position. The number in this text box shows the horizontal distance by which an entry has 
been displaced from its default placement in the measure. Any time you drag a note to the 
right with the Speedy Entry or Special Tools Tool, you increase this value; if you drag a note 
to the left, you decrease this value.

• Entry Slot (#). This indicator lets you know which note, chord, or rest (entry) you’re looking 
at. The first entry in the measure is 0, and the “slots” are numbered from left to right; there’s 
an invisible “end-of-measure” slot in each measure, too. (A measure with four notes and a 
rest, therefore, has six slots including this “end-of-measure” slot.)

• Prev Entry • Next Entry. Click these buttons (at the top of the dialog box) to scroll from one 
entry to another within the measure.

• Entry Slot: Add • Delete. These buttons insert an entry into, or remove the currently dis-
played entry from, the measure. 

• Articulation. If this checkbox is selected, there’s an articulation mark attached to currently 
displayed entry.

• Beam/Beat. If this checkbox is selected, the currently displayed entry isn’t beamed to the 
notes before it.

• Beam Ext. If this checkbox is selected, the currently displayed entry’s beam has been 
extended with the Beam Extension Tool (within the Special Tools Tool).

• Chord. If this checkbox is selected, there’s a chord symbol attached to the currently displayed 
entry.

• Clef Change. This very technical item is used by Finale’s internal drawing routines. Whether 
or not the checkbox is selected makes no difference to the screen display.

• Cross Up. If this checkbox is selected, one or more of the notes of the currently displayed 
entry is cross-staff note.

• Double Stem. If this checkbox is selected, the currently displayed entry has both an upstem 
and a downstem, created with the Double/Split Stem Tool (within the Special Tools Tool).

• Flip Tie. If this checkbox is selected, you have flipped the tie upside-down, either locally 
(using Special Tools or Speedy), or by your settings in the Layer Options dialog box.

• Float Rest. If this checkbox is selected, the currently displayed entry (if it’s a rest) is fixed on 
the middle staff line (or another line, if you’ve established Layer Options [Options Menu] that 
reposition all rests in a layer). If this checkbox is not selected, you can drag the rest up and 
down with the Speedy Entry Tool.

• Freeze Beam. If this checkbox is selected, the currently displayed entry’s beam has been fro-
zen either joined or broken. Additional changes to the measure will not change the state of the 
beam, found in the Beam/Beat box. Mass Mover/Rebeam will override this setting.

• Freeze Stem. If this checkbox is selected, the currently displayed entry’s stem has been frozen 
up or down. (See the checkbox labeled Up/Down in the fourth column of dialog box items; if 
it’s selected, the stem is frozen up.)

• Grace. If this checkbox is selected, the currently displayed entry is a grace note.
• Ignore. If this checkbox is selected, the currently displayed entry is invisible and doesn’t play 

back (because you’ve pressed the O key using the Speedy Entry Tool).
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• Ledger. This option is selected by default, so that Finale automatically draws ledger lines for 
all notes that need them. To hide ledger lines on a particular entry, deselect this option. When 
you return to the score, the ledger lines will no longer appear on that entry. To display ledger 
lines for an entry that have been hidden, select this option for the entry.

• Legality. The function of this checkbox is extremely technical; you should never need to click 
it. Briefly, when not selected, this checkbox hides the currently displayed note and all subse-
quent notes or rests in the measure. In other words, an entry whose Legality checkbox isn’t 
selected acts as an “end-of-measure” mark to Finale (see Entry Slot [#],” above)—meaning 
that Finale ignores it and any subsequent notes.

• Note Detail. If this checkbox is selected, the currently displayed entry (including its notehead, 
stem, and beam, if any) has been resized with the Resize Tool, or its notehead or accidental 
has been modified with the Notehead or Accidental tools (within the Special Tools Tool).

• Note/Rest. If this checkbox is selected, the currently displayed entry is a note; if not, it’s a 
rest.

• Perf Data. If this checkbox is selected, there’s performance data (key velocity and Start/Stop 
Time information) associated with the currently displayed note.

• Reverse Up • Reverse Dn. If one of these checkboxes is selected, a reverse upstem or down-
stem, respectively (on the “wrong” side of the notehead) has been added to the currently dis-
played entry with the Reverse Stem Tool (within the Special Tools Tool). 

• Sec Beam. If this checkbox is selected, you’ve made adjustments to the beaming of the cur-
rently displayed entry with the Secondary Beam Break Tool (within the Special Tools Tool).

• Slur. If this option is selected, the entry has a note-assigned Smart Shape slur attached to it. 
This option is provided for reference only; you should not change this setting manually.

• Special. If this checkbox is selected, the currently displayed entry’s tie or dot has been modi-
fied with the Tie or Dot Tools (within the Special Tools Tool).

• Split Stem. If this checkbox is selected, one or more notes of the currently displayed entry 
have split stems created with the Double/Split Stem Tool (within the Special Tools Tool).

• Note-attached Expression. If this checkbox is selected, there’s a note attached expression 
attached to currently displayed entry.

• Slash Grace. If this checkbox is selected the grace note is slashed.
• Stem Detail. If this checkbox is selected, the currently displayed entry’s stem has been modi-

fied with the Custom Stem, Stem Length, Beam Angle, or Secondary Beam Angle tools 
(within the Special Tools Tool).

• Text Detail. If this checkbox is selected, there’s a lyric syllable attached to currently displayed 
entry.

• Tuplet. If this checkbox is selected, the currently displayed entry is the first note of a tuplet.
• Up/Down. If the Freeze Stem checkbox is selected, this checkbox indicates whether the cur-

rently displayed entry’s stem has been frozen up or down. If Up/Down is selected, the stem is 
frozen up; if not, it’s frozen down.

• Voice 2. If this checkbox is selected, the currently displayed entry belongs to Voice 2.
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• V2 Beam. Under normal circumstances, you can’t beam together notes in Voice 2 that have 
been “launched” from different Voice 1 notes. Select this checkbox for the first note of the sec-
ond of two Voice 2–launched groups; you’ll now be able to beam the first group to the second 
in the usual way (using the slash key in the Speedy Entry Tool).

• V2 Launch. If this checkbox is selected, a second voice (V2) has been “launched” from the 
currently displayed entry.

• V2 Tup Para. This element is one of the few Edit Frame dialog box items you might want to 
edit yourself. It’s used only in one particular circumstance: a tuplet in Voice 2 is being over-
lapped (in time) by a tuplet in Voice 1. If such a situation arises and you notice that the tuplets’ 
spacing isn’t correct, select this checkbox for the first note of the Voice 2 tuplet to correct the 
notes’ positioning. In the figure below, you’d select V2 Tup Para for the first note of the 
eighth-note (Voice 2) triplet.

• Note Slot (#). This indicator specifies which of the notes in a chord you’re looking at. The 
notes of a chord are numbered from bottom to top, beginning with the number 0.

• Prev Note • Next Note. Click these two buttons (near the bottom of the dialog box) to scroll 
from one note to another within a chord. (Prev moves you from the bottom to top note, and 
Next moves you from top to bottom.)

• Note Slot: Add • Delete. These buttons insert a note into, or remove the currently displayed 
note from, a chord.

• Note ID. The number in this text box identifies the currently displayed note in the chord. 

• Displacement. The number in this text box identifies the currently displayed note’s pitch, 
expressed as a number of diatonic steps away from the first note of the scale (the tonic). The 
note E is two scale degrees above C, so its Displacement in the key of C is 2.

• Raise/Lower. The number in this text box specifies the amount (in half steps) the currently 
displayed note has been raised or lowered from its unmodified diatonic scale degree by the 
addition of accidentals. A Bf in the key of C has a Raise/Lower value of –1. An Fs in the key 
of C has a Raise/Lower value of 2.

• Accidental. If this checkbox is selected, the currently displayed note’s accidental appears, 
even if it wouldn’t normally (such as the natural before a C in the key of C)—sometimes 
called a courtesy accidental.

• (Accidental). If this checkbox is selected, there’s an accidental in parentheses on the current 
entry.

• Cross Note. If this checkbox is selected, the currently displayed note is a cross-staff note.

• Freeze Accidental. An X in this checkbox indicates that you’ve forced an accidental to appear 
(or not to appear) by pressing the asterisk key while editing with the Speedy Entry Tool.
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• Legality. This checkbox, when not selected, hides the currently displayed note and all subse-
quent notes in the chord, serving as an “end-of-chord” marker for Finale.

• Playback. If this checkbox is selected, the note will sound during playback.
• Spacing. If this checkbox is selected, the currently displayed entry will affect how Finale 

spaces the music. If this checkbox is unchecked, Finale will ignore the entry when calculating 
the music spacing.

• Tie Start • Tie End. These checkboxes indicate whether a tie begins or ends on the currently 
displayed note. Do not edit these checkboxes.

• Upstem 2nd • Downstem 2nd. If this checkbox is selected, the currently displayed note’s 
notehead is drawn on the “wrong” side of its stem, usually because it’s an interval of a second 
from another note in the same chord. (Upstem and Downstem refer to the stem direction.)

• Upstem Split. If this checkbox is selected, the currently displayed note’s stem has been 
“split” from the other notes of the chord, using the Double/Split Stem Tool (within the Special 
Tools Tool), and the currently displayed note has been assigned to the upward stem.

• OK • Cancel. Click OK (or press enter) to confirm the settings you’ve made in this dialog box 
and return to the score. Click Cancel to tell Finale to ignore any changes you made in this dia-
log box. You return to the score.
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Quantization Settings Guide
Your success at creating notation with the HyperScribe Tool depends largely on the settings you 
make in the Quantization Settings dialog box. The more simple the assortment of rhythmic values 
in your piece, the better Finale will transcribe them; but Finale can handle even rhythmically com-
plex pieces if you’ve made the proper settings.

These settings include your beat source (called Time Tags in the Transcription window), the 
smallest note you will input, and your quantization type settings. For a complete discussion of the 
beat source and quantization options, see QUANTIZATION SETTINGS DIALOG BOX, RECORDING 
WITH HYPERSCRIBE and TRANSCRIBING A SEQUENCE).

The following table is designed to help you make the correct quantization settings before you 
begin. Consult this table if you find that (1) Finale is quantizing (rounding off) smaller values—
such as sixteenth notes—into chord clusters with larger values, such as eighth notes, or (2) Finale 
isn’t quantizing enough—in other words, you’re finding that eighth notes are being notated as six-
teenth notes separated by sixteenth rests, for example, or (3) Finale isn’t correctly notating triplets 
or other tuplets.

Consult the Beat (Tap), Rhythm and Time columns of this table to find the assortment of rhythmic 
values and Time Signatures that correctly characterizes the rhythmic values of the piece you’re 
trying to notate.The Smallest Note Value and Type of Quantization columns show you what set-
tings to use in the Quantization Settings dialog box to notate the described rhythm.

(To specify a Beat Duration—that is, the rhythmic value of your tap—in HyperScribe, choose Tap 
from the HyperScribe Menu and click a note value in the Tap Source dialog box. In the Transcrip-
tion window, choose the corresponding value from the “First Tag is” submenu of the Time Tag 
Menu before you record Time Tags.)

Beat (Tap) Rhythm Time
Smallest 

Note
Type of Quantization

2

4
e

Space Notes Evenly

3

4
x

Space Notes Evenly

3

4
x

Space Notes Evenly

4

4
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Space Notes Evenly
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Mix Rhythms

2

2
q

Mix Rhythms

2

2
e

Mix Rhythms
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Space Notes Evenly
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2
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Mix Rhythms

6

8
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Space Notes Evenly

3

2
e

Mix Rhythms

2

4
x

Space Notes Evenly

4

4 32nd note Space Notes Evenly

6

4
e

Mix Rhythms

Beat (Tap) Rhythm Time
Smallest 

Note
Type of Quantization
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More on MIDI
MIDI stands for Musical Instrument Digital Interface. It’s a communications protocol for comput-
ers and synthesizers that was developed in 1983 through the collaboration of several major elec-
tronic instrument manufacturers. By linking different MIDI devices together by MIDI cables, you 
have great flexibility: a key you strike on one MIDI instrument (the keyboard controller) can pro-
duce sound from a second MIDI instrument—or several other MIDI instruments; a note played by 
a person can be precisely recorded and reproduced by a computer; and a computer can play many 
MIDI instruments at once in perfect synchronization. This part of the appendix covers some 
sophisticated aspects of MIDI that may help you to understand Finale better.

A MIDI signal, or event, is transmitted in a burst of two or three bytes (pieces of computer data in 
numeric form). The first byte of every event is called the status byte, because it identifies by num-
ber the kind of event being transmitted—a note being struck, the pedal being released, and so 
on—and what MIDI channel it’s being sent on. The other bytes are called data bytes, because they 
tell the computer or MIDI instrument which MIDI device (of the type described by the status 
byte) is being operated, and by how much its status has changed. For example, when you strike a 
note, the data bytes produced describe which note you played and how hard you struck the key.

Here are some of the various MIDI events described by the status byte and what kind of informa-
tion is conveyed by the corresponding data bytes.

In a few Finale dialog boxes you’ll see sets of three text boxes containing numbers preceded by a 
dollar sign. These three boxes contain hexadecimal notation for the three bytes in a MIDI event: 
from left to right, the status byte and the two data bytes. If you backspace over the dollar sign, 
however, you can enter normal (decimal notation) numbers instead of hexadecimal notation; 
Finale will translate your numbers into hexadecimal notation automatically. (Note that most times 
you see the MIDI data text boxes like this, you’ll also see a Listen button. The Listen button lets 
you play the MIDI event being requested; Finale translates the key, pedal, or controller you play 
into hexadecimal notation automatically.)

While the events in the table above are described by MIDI status bytes, there’s another class of 
status bytes called System status bytes that are independent of any particular MIDI channel. They 
include MIDI Sync data; Sequencer Start, Stop, and Continue commands; System Exclusive data 
(unique to each synthesizer); and other synchronization and system-exclusive data.

MIDI event described by status byte Parameters described by data bytes

Note On (pressing a key) MIDI key number and key velocity

Note Off (releasing a key) MIDI key number and release velocity

Polyphonic Aftertouch (channel pressure) MIDI key number and amount of pressure applied

Controller Controller number and its value (see next table) 

Patch Change Patch number

Monophonic Aftertouch (channel pressure) Amount of pressure applied after note is struck

Pitch Bend Position of pitch wheel

System Codes Variable
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Often in the Finale manual you’ll encounter the term MIDI controller. Controller data is usually 
produced by a MIDI device that affects the MIDI notes you’re playing—pedals, pitch and modu-
lation wheels, breath controllers, and so on. There are some useful controllers that are settings 
more than they are devices: MIDI volume level, tremolo depth, and right/left stereo pan are exam-
ples. In the table below, the most common MIDI controllers are listed along with their controller 
numbers. 

Armed with these controller numbers, you can use Finale’s Expression or MIDI tools to add this 
kind of data to the playback of your scores.

Controller 
number

Controller
Controller 

number
Controller

1 Modulation Wheel (or Lever) 64 Sustain

2 Breath Controller 65 Portamento

4 Foot Controller 66 Sostenuto

5 Portamento time 67 Soft Pedal

7 Main volume 91 External Effects Depth

8 Balance 92 Tremolo Depth

10 Pan 93 Chorus Depth

11 Expression Controller
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General MIDI Patch Set Groupings Table
The patches, or sounds, in General MIDI are grouped according to the following table. This 
grouping is used for all channels except for channel 10, which is used for percussion.

General MIDI Table
This list contains all the General MIDI Patch Numbers and Patch Names.

Patch 
Number

Sound Set
Patch 

Number
Sound Set

1-8 Piano 65-72 Reed

9-16 Chromatic Percussion 73-80 Pipe

17-24 Organ 81-88 Synth Lead 

25-32 Guitar 89-96 Synth Pad

33-40 Bass 97-104 Synth Effects

41-48 Strings 105-112 Ethnic

49-56 Ensemble 113-120 Percussive

57-64 Brass 121-128 Sound Effects

Patch 
Number

Name
Patch 
Number

Name
Patch 
Number

Name

1 Acoustic Grand Piano 16 Dulcimer 31 Distortion Guitar

2 Bright Acoustic Piano 17 Drawbar Organ 32 Guitar Harmonics

3 Electric Grand Piano 18 Percussive Organ 33 Acoustic Bass

4 Honky-tonk Piano 19 Rock Organ 34 Electric Bass (finger)

5 Electric Piano 1 20 Church Organ 35 Electric Bass (pick)

6 Electric Piano 2 21 Reed Organ 36 Fretless Bass

7 Harpsichord 22 Accordion 37 Slap Bass 1

8 Clavi 23 Harmonica 38 Slap Bass 2

9 Celesta 24 Tango Accordion 39 Synth Bass 1

10 Glockenspiel 25 Guitar (nylon) 40 Synth Bass 2

11 Music Box 26 Acoustic Guitar (steel) 41 Violin

12 Vibraphone 27 Electric Guitar (jazz) 42 Viola

13 Marimba 28 Electric Guitar (clean) 43 Cello

14 Xylophone 29 Electric Guitar (muted) 44 Contrabass

15 Tubular Bells 30 Overdriven Guitar 45 Tremolo Strings
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46 Pizzicato Strings 74 Flute 102 FX 6 (goblins)

47 Orchestral Harp 75 Recorder 103 FX 7 (echoes)

48 Timpani 76 Pan Flute 104 FX 8 (sci-fi)

49 String Ensemble 1 77 Blown Bottle 105 Sitar

50 String Ensemble 2 78 Shakuhachi 106 Banjo

51 SynthStrings 1 79 Whistle 107 Shamisen

52 SynthStrings 2 80 Ocarina 108 Koto

53 Choir Aahs 81 Lead 1(square) 109 Kalimba

54 Voice Oohs 82 Lead 2 (sawtooth) 110 Bag Pipe

55 Synth Voice 83 Lead 3 (calliope) 111 Fiddle

56 Orchestra Hit 84 Lead 4 (chiff) 112 Shanai

57 Trumpet 85 Lead 5 (charang) 113 Tinkle Bell

58 Trombone 86 Lead 6 (voice) 114 Agogo

59 Tuba 87 Lead 7 (fifths) 115 Steel Drums

60 Muted Trumpet 88 Lead 8 (bass+lead) 116 Woodblock

61 French Horn 89 Pad 1 (new age) 117 Taiko Drum

62 Brass Section 90 Pad 2 (warm) 118 Melodic Tom

63 SynthBrass 1 91 Pad 3 (polysynth) 119 Synth Drum

64 SynthBrass 2 92 Pad 4 (choir) 120 Reverse Cymbal

65 Soprano Sax 93 Pad 5 (bowed) 121 Guitar Fret Noise

66 Alto Sax 94 Pad 6 (metallic) 122 Breath Noise

67 Tenor Sax 95 Pad 7 (halo) 123 Seashore

68 Baritone Sax 96 Pad 8 (sweep) 124 Bird Tweet

69 Oboe 97 FX 1 (rain) 125 Telephone Ring

70 English Horn 98 FX 2 (soundtrack) 126 Helicopter

71 Bassoon 99 FX 3 (crystal) 127 Applause

72 Clarinet 100 FX 4 (atmosphere) 128 Gunshot

73 Piccolo 101 FX 5 (brightness)

Patch 
Number

Name
Patch 
Number

Name
Patch 
Number

Name
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General MIDI Percussion Map Table
This listing contains all the General MIDI percussion tones on channel 10, which is the channel 
reserved for percussion.

Note 
Number

Name
Note 
Number

Name

35 Acoustic Bass Drum 59 Ride Cymbal 2

36 Bass Drum 1 60 Hi Bongo

37 Side Stick 61 Low Bongo

38 Acoustic Snare 62 Mute Hi Conga

39 Hand Clap 63 Open Hi Conga

40 Electric Snare 64 Low Conga

41 Low Floor Tom 65 High Timbale

42 Closed Hi Hat 66 Low Timbale

43 High Floor Tom 67 High Agogo

44 Pedal Hi Hat 68 Low Agogo

45 Low Tom 69 Cabasa

46 Open Hi Hat 70 Maracas

47 Low-Mid Tom 71 Short Whistle

48 Hi-Mid Tom 72 Long Whistle

49 Crash Cymbal 1 73 Short Guiro

50 High Tom 74 Long Guiro

51 Ride Cymbal 1 75 Claves

52 Chinese Cymbal 76 Hi Wood Block

53 Ride Bell 77 Low Wood Block

54 Tambourine 78 Mute Cuica

55 Splash Cymbal 79 Open Cuica

56 Cowbell 80 Mute Triangle

57 Crash Cymbal 2 81 Open Triangle

58 Vibraslap
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Template Percussion Mappings
MIDI pitches, notehead and placement for percussion staves in the following templates:

Full Concert Band, Small Concert Band, Wind Ensemble, Percussion, Church Orchestra, 
Brass Band and Full Orchestra

35 Acoustic Bass 36 Bass Drum 1 37 Side Stick 38 Acoustic Snare 39 Hand Clap

40 Electric Snare 41 Low Floor Tom 42 Closed Hi Hat 43 High Floor Tom 44 Pedal Hi Hat

45 Low Tom 46 Open Hi Hat 47 Low Mid Tom 48 Hi Mid Tom 49 Crash Cymbal 1

50 High Tom 51 Ride Cymbal 1 52 Chinese Cymbal 53 Ride Bell 54 Tambourine

55 Splash Cymbal 56 Cowbell 57 Crash Cymbal 2 58 Vibra Slap 59 Ride Cymbal 2

60 Hi Bongo 61 Low Bongo 62 Mute Hi Conga 63 Open Hi Conga 64 Low Conga

65 High Tambale 66 Low Timbale 67 High Agogo 68 Low Agogo 69 Cabasa

70 Maracas 71 Short Whistle 72 Long Whistle 73 Short Guiro 74 Long Guiro

75 Claves 76 Hi Wood Block 77 Low Wood Block 78 Mute Cuica

79 Open Cuica 80 Mute Triangle 81 Open Triangle
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Jazz Band and SATB with Piano, Bass and Drums templates

36 Bass Drum 1 37 Side Stick 38 Acoustic Snare 40 Electric Snare

41 Low Floor Tom 42 Closed Hi Hat 43 High Floor Tom 44 Pedal Hi Hat

45 Low Tom 46 Open Hi Hat 47 Low Mid Tom 48 Hi Mid Tom

49 Crash Cymbal 1 50 High Tom 51 Ride Cymbal 1 52 Chinese Cymbal

53 Ride Bell 55 Splash Cymbal 56 Cowbell 57 Crash Cymbal 2 59 Ride Cymbal 2

Marching Band template

37 Side Stick 38 Acoustic Snare 39 Hand Clap 40 Electric Snare 42 Closed Hi Hat 46 Open Hi Hat

49 Crash Cymbal 1 51 Ride Cymbal 52 Chinese Cymbal 53 Ride Bell 55 Splash Cymbal

57 Crash Cymbal 59 Ride Cymbal 69 Cabasa 70 Maracas 75 Claves

36 Bass Drum 1 37 Side Stick 41 Low Floor Tom 43 Hi Floor Tom 45 Low Tom 47 Low Mid Tom

48 Hi Mid Tom 50 High Tom

35 Acoustic Bass Drum 36 Bass Drum 1 37 Side Stick 41 Low Floor Tom 43 High Floor Tom 45 Low Tom
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Bank Select - Bank Change Table
The following table provides a list of MIDI instruments and the bank select method used for them. 
When defining the type of patch you'll send from Finale, choose the appropriate method from the 
Patch drop-down list. For example for the Roland D-20, choose “Bank Select 0, Bank Select 32, 
Program Change” from the drop-down list. For the Yamaha TG300, choose “Bank Select 0, Pro-
gram Change” from the drop-down list.

Instrument Bank Select Method Patch drop-down list selection

Alesis QS6 Controller 0 Only Bank Select 0, Program Change

Alesis Quadra Synth Plus Controller 0 Only Bank Select 0, Program Change

Casio CT-470 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Creative Labs, Sound Blaster AWE-32 Controller 0 Only Bank Select 0, Program Change

E-MU Classic Keys Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

E-MU Proteus FX Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Ensoniq KS-32 Patch 100..127 Program Change, Program Change

Ensoniq SQ1 Patch 100..127 Program Change, Program Change

Ensoniq TS-10 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Ensoniq VFX Patch 100..127 Program Change, Program Change

GeneralMusic, S MusicProcessor Controller 0 Only Bank Select 0, Program Change

GeneralMusic, WX/SX Series Controller 0 Only Bank Select 0, Program Change

Kawai K-11 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Korg 01/W Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Korg 03R/W Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Korg 05R/W Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Korg i3 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Korg T3 Patch 100..127 Program Change, Program Change

Korg Wavestation Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Korg X3 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Korg X5DR Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Kurzweil 1000PX A/B Patch 100..127 Program Change, Program Change

Kurzweil K1000 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Kurzweil K2000 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Kurzweil K2500 Controller 32 Only Bank Select 32, Program Change

Kurzweil MASS Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change
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Kurzweil PC-88mx Controller 32 Only Bank Select 32, Program Change

Oberheim 1000 Controller 32 Only Bank Select 32, Program Change

Peavey Spectrum Bass Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Roland D-20 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Roland D-70 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Roland GR-1 Controller 0 Only Bank Select 0, Program Change

Roland GS Controller 0 Only Bank Select 0, Program Change

Roland GS mkII Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Roland GS SC-55 Controller 0 Only Bank Select 0, Program Change

Roland GS SC-88 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Roland JD-990 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Roland JV-1080 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Roland JV-880 Controller 0 Only Bank Select 0, Program Change

Roland JV-90 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Roland Super JV-1080 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Roland U-220 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Roland XP-50 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Technics KN1000 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Technics PR307 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Yamaha SY-35 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Yamaha SY-77 Patch 100..127 Program Change, Program Change

Yamaha SY-85 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Yamaha SY-99 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Yamaha TG-100 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Yamaha TG-300 Controller 0 Only Bank Select 0, Program Change

Yamaha TG-33 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Yamaha TG-500 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Yamaha TX-7 Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Yamaha W5/7 Controller 0 Only Bank Select 0, Program Change

Yamaha XG Controller 0 and 32 Bank Select 0, Bank Select 32, Program Change

Instrument Bank Select Method Patch drop-down list selection
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Harmony Presets
These harmony presets are used in the Band-in-a-Box Harmonizer plug-in. For more information, 
see BAND-IN-A-BOX AUTO-HARMONIZER PLUG-IN.

Two Part Three Part Four Part Five Part Six Part

Guitar 3rds & 6ths Guitar Jazz Piano Jazz Piano Guitar

3rds & 6ths Below Drop 2 Guitar Drop 2 Drop Two (SuperSax) Big Band Brass

3rd Below Drop 2 - 8vb Swing Guitar Swing Woodwinds Male Choir

6th Below 6ths Above & 
Below

Super Brass Close Vocal Country Vocal

3rds & 6ths Above Two Below #1 Strings Female Choir Three Below 8va & 8vb

3rd Above Two Below #2 Strings 8va Male Choir 3rd Above 8va & 8vb

6th Above Two Below #3 Strings 8vb Four Below 6th Above 8va & 8vb

Octave Below One Above #1 Barbershop Close 3rd Above 8vb Alt Above 8va & 8vb

Octave Below (Long 
Notes)

One Above #2 Barbershop Open 6th Above 8vb Two Above 8va & 8vb #1

Two Octaves Below One Above #3 Drop 2 Alt Above 8vb Two Above 8va & 8vb #2

Octave Above Two Above #1 Drop 3 Two Above 8vb #1 Two Above 8va & 8vb #3

Two Above #2 Three Below #1 Two Above 8vb #2 Two Above 8va & 8vb #4

Two Above #3 One Above #1 Two Above 8vb #3 Three Above 8va & 8vb

3rds & 6ths Below 
8vb

One Above #2 Three Above 8vb Four Above 8va

3rd Below 8vb Two Above #1 Three Below 8va

6th Below 8vb Two Above #2 6th Above 8va

3rd Above 8vb Three Above Alt Above 8va

6th Above 8vb 3rd Above 8vb #1 Two Above 8va #1

3rds & 6ths Above 
8va

3rd Above 8vb #2 Two Above 8va #2

3rd Above 8va 6th Above 8vb #1 Three Above 8va #1

6th Above 8va 6th Above 8vb #2 Three Above 8va #2

3rd Below 8va Alt Above 8vb #1 Three Above 8va #3

6th Below 8va Alt Above 8vb #2 Two Below 8va & 8vb #1

Octaves 8va & 8vb Two Above 8vb #1 Two Below 8va & 8vb #2

Two Above 8vb #2 Two Below 8va & 8vb #3

Two Above 8vb #3 3rd Above 8va & 8vb

Two Above 8va #1 6th Above 8va & 8vb

Two Above 8va #2 Alt Above 8va & 8vb

6th Above 8va #1 Two Above 8va & 8vb #1

6th Above 8va #2 Two Above 8va & 8vb #2
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Exercise numbers in the Exercise Wizard
Scales (1-1999) Arpeggios (4000-4999)

Intervals (2000-3999)

3rd Above 8va #1 Two Above 8va & 8vb #3

3rd Above 8va #2

Alt Above 8va #1

Alt Above 8va #2

Two Below 8va #1

Two Below 8va #2

Two Below 8va #3

3rd Below 8va & 8vb

6th Below 8va & 8vb

3rd Above 8va & 8vb

6th Above 8va & 8vb

Exercise Family Exercise numbers Exercise Family Exercise numbers

Major 1-99 Major Triad 4000-4099

Natural Minor 100-199 Minor Triad 4100-4199

Harmonic Minor 200-299 Diminished Triad 4200-4299

Melodic Minor 300-399 Augmented Triad 4300-4399

Chromatic 400-499 Major Seventh 4400-4499

Whole Tone 500-599 Minor Seventh 4500-4599

Pentatonic 600-699 Dominant Seventh 4600-4699

Diminished 700-799

Exercise Family Exercise numbers

Seconds 2000-2199

Thirds 2200-2399

Fourths 2400-2599

Fifths 2600-2799

Sixths 2800-2999

Sevenths 3000-3199

Two Part Three Part Four Part Five Part Six Part
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Document Settings and Program Settings
The following document settings are saved with the document. This means that opening this doc-
ument on another computer would not change these settings. Program Settings are specific to a 
particular installation of Finale.

Octaves 3200-3399

Mixed 3600-3799

Document Settings Program Settings

Edit Menu/Special Part Extraction Edit Menu/Select Partial Measures

Edit Menu/Snap to Grid Edit Menu/Automatic Update Layout

Edit Menu/Snap to Guide Edit Menu/Automatic Music Spacing

View Menu/Scroll or Page View View Menu/Redraw Options/Redraw Controls

View Menu/View Percentage View Menu/Select Display Colors

View Menu/Staff Sets Palette Configuration

View Menu/Grid Guide Options View Menu/Show Margins

View Menu/Show Grid View Menu/Show System Locks

View Menu/Show Guides Options Menu/Enharmonic Spelling

View Menu/Show Rulers Click and Countoff dialog box

View Menu/Layer Selection Movable Items dialog box

View Menu/Show Active Layer Only Program Options dialog box

View Menu/Show Multiple Pages Other Program Options dialog box

Options Menu/Display in Concert Pitch Update Layout Options dialog box

Quantization Settings dialog box

Select Default Fonts dialog box MIDI Setup dialog box

Chord Alternate Baseline dialog box MIDI Thru dialog box

Playback Options dialog box MIDI Thru Table dialog box

Augmentation Dot dialog box Import MIDI File Options dialog box

Barlines dialog box Export MIDI File Options dialog box

Clef Designer dialog box MIDI Menu/16-bit/32 bit MIDI driver

Curves dialog box Window Menu/Main Tool Palette

Document Options dialog box Window Menu/Simple Entry Palette

Exercise Family Exercise numbers
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Layer Options dialog box Window Menu/Simple Entry Rests Palette

Lines dialog box Window Menu/Smart Shape Palette

Multimeasure Rest dialog box Window Menu/Special Tools Palette

Music Characters dialog box Window Menu/Instrument List

Music Character Positioning dialog box Window Menu/Playback Controls

Music Options dialog box Window Menu/Main Tool Bar

Music Spacing Options dialog box Window Menu/Status Bar

Notation Options dialog box Staff Menu/Show Staff Styles

Note Shapes dialog box Staff Menu/Show Default Staff Names

Page Format for Score dialog box Staff Menu/Show Default Group Names

Page Format for Parts dialog box Staff Menu/Auto Sort Staves

Piano Braces dialog box Measure Menu/Dragging Selects Measure Handles

Repeat Bars dialog box Measure Menu/Dragging Selects Number Handles

Repeat Endings dialog box Simple Menu/Check for Extra Notes

Stem Connections dialog box Simple Menu/Playback

Text Inserts dialog box Speedy Menu/Use MIDI keyboard

Tie Options dialog box Speedy Menu/Playback During Drag

Tie Contour dialog box Speedy Menu/Jump to Next Measure

Time Signature Options dialog box Speedy Menu/Create New Measures

Extract Parts dialog box Speedy Menu/Check Beaming

File Info dialog box Speedy Menu/Check Accidentals

Page Setup dialog box Speedy Menu/Check for Extra Notes

Edit Staff Attributes dialog box Speedy Menu/Use Five Line Staff

Select Clef dialog box Speedy Menu/Auto Freeze Accidentals

Edit Full Staff Name dialog box Speedy Menu/Edit Tab

Position Full Staff Name dialog box Speedy Menu/Insert Notes

Edit Abbreviated Staff Name dialog box HyperScribe Menu/Beat Source

Position Abbreviated Staff Name dialog box HyperScribe/Record Mode

Staff Transposition dialog box HyperScribe/Transcription Mode

Alternate Notation dialog box Tap dialog box

Staff Setup dialog box MIDI Event dialog box

Percussion Map Selection dialog box Tap States dialog box

Document Settings Program Settings
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Percussion Map Designer dialog box Playback and/or Click dialog box

Symbol Selection dialog box HyperScribe Options dialog box

Note Shapes dialog box Fixed Split Point dialog box

Tablature dialog box Moving Split Point dialog box

Define Staff Styles dialog box MIDI Input Filter dialog box

Apply Staff Styles dialog box Transcription Filter dialog box

Group Attributes dialog box Punch-in Pre-Roll dialog box

Respace Staves dialog box Click Input dialog box

Staff Usage dialog box Click Output dialog box

Staff Menu/Set Default Names/Full Staff Names Expression Menu/Show All Handles

Staff Menu/Set Default Names/Abbreviated Staff Names Expression Menu/Metatool Attachment

Staff Menu/Set Default Names/Full Group Names Chord Menu/Input Method

Staff Menu/Set Default Names/Abbreviated Group Names Chord Menu/Substitute Symbols

Position Full Staff Names dialog box Chord Menu/Show All Handles

Position Abbreviated Staff Names dialog box Chord Menu/Italicize Capo Chords

Position Full Group Names dialog box Fretboards (View)

Position Abbreviated Group Names dialog box Fretboard Editor dialog box

Key Signature dialog box Note Mover Function

Non Standard Key Signature dialog box Rebar Options dialog box

Key Step Map dialog box Special Tools Menu/Show Handles

Accidental Order and Amount dialog box Special Tools Menu/Update

Tone Center(s) dialog box Special Tools Menu/Show Crosshairs

Accidental Octave Placement dialog box Special Tools Menu/Tie Direction

Special Key Signature Attributes dialog box

Symbol List dialog box

Time Signature dialog box

Composite Time Signature dialog box

Measure Menu/Measure Numbers Show/Hide

Measure Number dialog box

Enclosure Designer dialog box

Position Measure Number dialog box

Measure Attributes dialog box

Document Settings Program Settings
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Edit Frame dialog box

Default Tuplet Visual Definition dialog box

Smart Shape Menu/Direction

Slur Contour dialog box

Smart Shape Placement dialog box

Smart Shape Options dialog box

Articulation Selection dialog box

Expression Selection dialog box

Executable Shape Selection dialog box

Shape Selection dialog box

Rulers and Grid dialog box

Repeat Selection dialog box

Chord Menu/Chord Style

Chord Menu/Left Align Chords

Chord Menu/Show Guitar Fretboards

Chord Menu/Simplify Spelling

Chord Suffix Selection dialog box

Resize Fretboards dialog box

Fretboard Instrument Definition dialog box

Fretboard Styles dialog box

Fretboard Style Fonts and Shapes dialog box

Fretboard Barre Shape Selection dialog box

Fretboard Fingered String Shape Selection dialog box

Fretboard Open String Shape Selection dialog box

Fretboard Muted String Shape Selection dialog box

Fretboard Custom Shape Selection dialog box

Adjust Baselines dialog box

Lyric Options dialog box

Text Menu/Size

Text Menu/Style

Text Menu/Justification

Text Menu/Word Wrap

Document Settings Program Settings
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Text Menu/Attach to Measure/Page

Text Menu/Show Only On Screen

Font dialog box

Size dialog box

Baseline Shift dialog box

Superscript dialog box

Tracking dialog box

Character Settings dialog box

Page Offset dialog box

Line Spacing dialog box

Page Layout Menu/Avoid Margin Collision

Page Layout Menu/Update Page Format for Score

Edit System Margins dialog box

Adjust Staff System Range dialog box

Edit Page Margins dialog box

Adjust Page Range dialog box

Page Size dialog box

Tilting Mirror dialog box

Mirror Attributes dialog box

Transposition dialog box

Selective Mirror dialog box

Beaming Chart dialog box

Placeholder dialog box

Set Placeholder dialog box

Ossia Measure Designer dialog box

Ossia Measure Assignment dialog box

Ossia Page Assignment dialog box

Tempo Adjustment dialog box

Set Swing dialog box

Duration dialog box

Playback Settings dialog box

Instrument List dialog box

Document Settings Program Settings
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